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1.  WELCOME

On behalf of the Organizing and Program Committees, I welcome you to Cyprus and the 5th IEEE
Mediterranean Conference on Control and Systems (5th IEEE MED).  I hope that your trip to Paphos was
uneventful and that you are eager to participate in an exciting technical meeting.  We cannot, of course,
forget that we are on Cyprus, an island with rich history, natural beauty and legendary hospitality.
Therefore, my hope is that you will also have the opportunity to relax and enjoy all that Cyprus has to
offer.  After all, we should not “offend” the ancient Greek inhabitants of the island who used to live by
the saying: το τερπνον µετα του ωφελιµου, which loosely translates to: business with pleasure.

The 1997 Mediterranean Conference on Control and Systems, is the 5th such meeting held in the
Mediterranean and the second held in Cyprus.  It is co-sponsored by the IEEE Control Systems  Society,
the University of Cyprus, The Technical Universities of Crete and Patras, the IEEE Cyprus Section, the
IEE Cyprus Section and the IEEE Greek Chapter of the Control Systems Society.

The Conference is truly an international event, that attracted the attention of researchers in the field from
all over the world.  Authors are representing more than twenty countries and come from five continents.
The technical program consists of 129 contributed and special session papers, which are arranged in 24
sessions.  These papers will be presented over three days, Monday, Tuesday and Wednesday, July 21, 22
and 23 respectively.  Each day is divided into morning sessions (four parallel sessions) and afternoon
sessions (four parallel sessions).  The topics range from Hybrid and Intelligent Systems to Robust and
Adaptive Control, Automotive Systems and Digital Signal Processing.  The Conference Plenary Lecture
is:

Monday morning at 8:30
Professor Sanjoy Mitter  of the Massachusetts Institute of Technology
Logic, Mathematical Programming and Hybrid Systems

A brief biography of the plenary speaker can be found below.

The Conference Proceedings will be published on CD-ROM, which is a first for the MED Conference.
This is in response to the trend in conference publications of recent years.  This medium offers expanded
search capabilities for conference proceedings readers and is arguably a more efficient method to
disseminate information.  Most of the papers included in the CD-ROM were submitted to the CD-ROM
producer electronically.  In addition to the CD-ROM, each conference participant will receive a hardcopy
Conference Program which includes a Book of Abstracts.



The planning, organization and running of this Conference, was done exclusively by volunteers.  Without
their tireless efforts this Conference would not run smoothly.  I would like to give special thanks to Petros
Ioannou, for handling finances, registration, hotel arrangements and special events.  Many thanks go to
Vassilis Syrmos, the Publicity Chair and the members of the Program Committee who helped with
reviews.  Thanks also go to Orhan Beker, for his help in producing the Book of Abstracts.  Most
importantly, many thanks go to the organizers of special sessions and all the authors, who have made this
Conference a reality.  Finally, let me also thank all attendees, who with their participation have ensured
the success of the 5th IEEE MED.

Theodore E. Djaferis
General/Program Chair, 5th IEEE MED



2.  CONFERENCE REGISTRATION

Most of the Conference attendees have pre registered for the Conference.  All who pre registered are
asked to go to the Conference Registration Desk, in order to obtain conference related material and
publications.  Those of you who chose to register on site are urged to do so as quickly as possible.  The
Conference Registration Desk will be open the following hours:

Sunday July 20, 6:30 p.m. to 8:30 p.m.
Monday July 21, 7:00 a.m. to 10:00 a.m. and 12:00 p.m. to 2:00 p.m.

The registration fee covers admission to all technical sessions, opening reception, coffee breaks and the
gala dinner.  Each registrant will also receive a copy of the Conference Program (which includes the Book
of Abstracts) and one CD-ROM with the Conference Proceedings.  Conference registrants may purchase
additional sets of CD-ROM Proceedings at the Registration Desk for $40 (20 Cyp. Pounds) each.

3.  SOCIAL EVENTS

• Opening Reception  (7:00 PM, Sunday, July 20)

On Sunday, July 20, 1997, there will be an opening reception held at the Phaethon between 7:00 p.m. and
9:00 p.m.  This will give the opportunity to Conference participants to meet and socialize.

• Gala Dinner  (8:00 PM, Tuesday, July 22)

On Tuesday, July 22, 1997, starting at 8:00 p.m. the evening Gala Dinner will take place at the taverna
Demokritos.  This is located within walking distance from the Phaethon and directions will be provided at
the Conference Registration desk.  Extra tickets for the gala dinner cost $25 (7.5 Cyp. Pounds) each.



4.  ABOUT CYPRUS AND PAPHOS

The island of Cyprus, is located in the north-eastern corner of the Mediterranean sea, about 200 miles east
of the island of Rhodes, 60 miles west from Syria, 250 miles north of Egypt and 40 miles south of
Turkey.  In size it is the third largest island in the Mediterranean, after Sicily and Sardinia, with an area of
3,572 square miles (9,251 square kilometers).  Its greatest breadth from north to south is 60 miles and its
greatest length from east to west is 140 miles.  The most prominent topographical features of the island
are two mountain ranges, Pendadaktylos (in Greek it means “five fingers”) to the north and Troodos to the
south, separated by the wide central plane Mesaoria (in Greek it means “between mountains”).  The
highest peak (6,401 feet) is in the Troodos range and is called Mount Olympus (or Chionistra).  Average
annual rainfall is about 19 inches, with the summer months being quite dry and hot.

The civilization of Cyprus dates back to the 7th millennium B.C., beginning with the Neolithic Age
(5800-3000 B.C.).  Its beauty, resources and strategic location have been sought after by friendly visitors
and conquerors alike for thousands of years.  Their passing have shaped its history, culture and
civilization and evidence of their presence can be found in the literally hundreds of archeological sites
throughout the island.  Its Greek heritage can be traced back three and a half thousand years to Mycenaean
settlers.  Archeological excavations have brought to light finds of all kinds: stone and bronze tools,
utensils, weapons, precious stones, gold silver coins, rings and bracelets, marble and bronze statues, etc..
Many are exhibited in the Cyprus Museum in Nicosia (the capital) and at museums at other parts of the
world.  One can see “history” everywhere on the island, remains of ancient cities, temples, theaters,
gymnasia, palaces, mosaics, Byzantine churches and monasteries with fresco paintings, mediaeval
crusader cathedrals, castles and walled cities, tekkes, aqueducts, etc..

Paphos, the Conference site, is located on the west coast of Cyprus.  It was founded in the fourth century
BC and was the capital of Cyprus during Roman times.  Places of interest in Paphos include: The Harbor,
first built in the time of Alexander the Great, rebuilt in 1592 A.D.;  St. Paul's Pillar to which St. Paul was
tied and scourged;  the Tombs of the Kings; the mosaics of the 3rd century A.D. which are the finest in
the Mediterranean.  Nearby, is Petra tou Romiou where according to legend Aphrodite emerged from the
waves, and the Temple of Aphrodite.  In addition to its rich history and archeological sites Paphos has
some of the best beaches in Cyprus.



5.  ON THE RECORD

The 1997 IEEE Mediterranean Conference on Control and Systems is the 5th such meeting held in this
region of the world.  Even though it is relatively “young” conference it nevertheless consistently attracts
leading researchers in the area of Control and Systems from all over the world.  The first, was held in
1993 and plans already exist for a number of future meetings: 6th IEEE MED Sardinia, Italy (1998); 7th
IEEE MED Haifa, Israel; 8th IEEE MED Porto, Portugal; 9th IEEE MED Patras, Greece; 10th IEEE
MED Barcelona, Spain.  Listed below are the past and present IEEE MEDs.

1st IEEE MEDITERRANEAN SYMPOSIUM ON NEW DIRECTIONS
IN CONTROL THEORY AND APPLICATIONS

June 21-23, 1993, Chania, Crete, Greece
General Chairman: M. A. Christodoulou

2nd IEEE MEDITERRANEAN SYMPOSIUM ON NEW DIRECTIONS
IN CONTROL AND AUTOMATION

June 19-21, 1994, Chania, Crete, Greece
General Chairman: K. P. Valavanis

3rd IEEE MEDITERRANEAN SYMPOSIUM ON NEW DIRECTIONS
IN CONTROL AND AUTOMATION

July 11-13, 1995, Limasol, Cyprus
General Chairman: P. A. Ioannou
Program Chairman: F. L. Lewis

4th IEEE MEDITERRANEAN SYMPOSIUM ON NEW DIRECTIONS
IN CONTROL AND AUTOMATION

June 10-13, 1996, Chania, Crete, Greece
General Chairman: F. L. Lewis

Program Co-Chairs: K. Kyriakopoulos and P. G. Voulgaris

5th IEEE MEDITERRANEAN CONFERENCE ON CONTROL AND SYSTEMS
July 21-23, 1997, Paphos, Cyprus

General and Program Chairman: T. E. Djaferis



6.  BIOGRAPHY OF THE PLENARY SPEAKER

Sanjoy Mitter received his Ph.D. degree from the Imperial College of Science and Technology,
University of London, in 1965.  He had previously worked as a research engineer at Brown Boveri & Co.
Ltd., Switzerland (now ASEA Brown Boveri) and Battelle Institute in Geneva, Switzerland.  He taught at
Case Western Reserve from 1965 to 1969 and joined MIT in 1969 first as a Visiting Professor and then in
1970 as Associate Professor in the Department of Electrical Engineering and Computer Science.  He is
currently Professor of Electrical Engineering and Co-Director of the Laboratory for Information and
Decision Systems.  He is also Director of the Center for Intelligent Control Systems, an inter-university
(Brown-Harvard-MIT) center for research on the foundations of intelligent systems.  He has held visiting
positions at the Tata Institute of Fundamental Research, Bombay, India; Scuola Normale Superiore, Pisa,
Italy; Imperial College of Science and Technology; Institut National de Recherche en Informatique et en
Automatique, France; University of Groningen, the Netherlands and several universities in the United
States.

Professor Mitter’s research has spanned the broad areas of Systems, Communication and Control.
Although his primary contributions have been on the theoretical foundations of the field, he has also
contributed to significant engineering applications, notably in the control of interconnected power systems
and automatic recognition and classification of electrocardiograms.  His current research interests are
theory of stochastic dynamical systems, nonlinear filtering, stochastic and adaptive control; mathematical
physics and its relationship to system theory; image analysis and computer vision; and structure, function
and organization of complex systems.

Professor Mitter has served on several advisory committees and editorial boards for IEEE, SIAM, AMS,
NSF and ARO.  He is currently Associate editor of Acta Applicandae Mathematicae; Circuits, Systems
and Signal Processing; Journal of Applied Mathematics and Optimization; SIAM Review; and the Ulam
Quarterly.  He is a fellow of the IEEE.  In 1988 he was elected to the National Academy of Engineering.
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5th  IEEE MEDITERRANEAN CONFERENCE ON CONTROL AND
SYSTEMS

Monday,  July  21

Chariot

Opening Remarks
8:20

Plenary Lecture
8:30-9:30

Logic, Mathematical Programming and Hybrid Systems
Sanjoy K. Mitter Massachusetts Inst. of Tech.

Chair: Theodore E. Djaferis, Univ. of Massachusetts Amherst
Co-Chair: Petros Ioannou, Univ. of Southern California



Chariot
MA1
Hybrid Systems
Chair: J. B. Remmel Sagent Corporation
Chair: C. Panayiotou Univ. of Massachusetts Amherst

10:00
Automaton Comparison Procedure for the Verification of Hybrid
Systems

Wolf Kohn Sagent Corporation
Jeffrey B. Remmel Sagent Corporation
Anil Nerode Cornell Univ.

10:30
A Hybrid Systems Approach to Feedback Control of a
Nonholonomic Vehicle

J. Almeida DEEC Univ. do Porto
F. Lobo Pereira DEEC Univ. do Porto
J. Borges Sousa DEEC Univ. do Porto

11:00
Discrete Levels Control of Nonlinear Systems

Photis G. Skiadas Univ. of Patras
Nick T. Koussoulas Univ. of Patras

11:30
A Framework for Hybrid Control Design and its Relations with a
Class of Fuzzy Control Systems

R. Fiero Univ. of Texas Arlington
F. L. Lewis Univ. of Texas Arlington
K. Liu Univ. of Texas Arlington

Apollo
MA2
Stochastic Systems
Chair: C. D. Charalambous McGill Univ.
Chair: R. P. Malhame Ecole Polytech. de Montreal

10:00
Estimation of Hidden Markov Models for Partially Observed
Risk Sensitive Control Problems

Bernard Frankpitt Univ. of Maryland
John Baras Univ. of Maryland

10:30
Linear Gaussian Quadratic Regulation Under Poisson Distrib-
uted Intermittent State Observations

M. Ades McGill Univ.
P. E. Caines McGill Univ.
R. P. Malhame Ecole Polytech. de Montreal

11:00
Finite-Dimensionality of Information States in Optimal Control
of Stochastic Systems

Charalambos D. Charalambous McGill Univ.

11:30
Tracking Changing Stochastic Models via Stochastic Binary
Neural Networks

Anthony Burell Univ. of Alabama
Achilles Kogiantis Univ. of Southwestern Louisiana
P. Papantoni-Kazakos Univ. of Alabama



Zeus
MA3
Modeling Estimation and Control of Infinite Dimensional
Systems I
Chair: M. A. Demetriou Worcester Polyt. Inst.
Chair: S. Reich Technion-Israel Inst. of Tech.
Org: H. T. Banks North Carolina State Univ.
Org: M.. A. Demetriou Worcester Polyt. Inst.

10:00
Spay Control

A. El Jai Univ. of Perpignan

10:30
Estimation and Control of Sample-Data Systems in Infinite
Dimensions

Akira Ichikawa Shizuoka Univ.

11:00
Fault Accommodation of Output-Induced Actuator Failures for a
Flexible Beam with Collocated Input and Output

Michael A. Demetriou Worcester Polyt. Inst.
Marios M. Polycarpou Univ. of Cincinati

11:30
Sampled Weighted Attraction Control of Distributed Thermal
Scan Welding

Charalambos C. Doumanidis Tufts Univ.

Lindos
MA4
Digital Signal Processing I
Chair: J. A. Stuller Univ. of Missouri-Rolla
Chair: T. Kasparis Univ. of Central Florida

10:00
Algorithms for Phase Acquisition for QAM Constellations

Costas N. Georghiades Texas A & M Univ.

10:30
Maximum Likelihood Estimation of Scale

John A. Stuller Univ. of Missouri-Rolla

11:00
A Novel BPSK Demodulator Using the Expectation Maximiza-
tion Algorithm

Takis Kasparis Univ. of Central Florida
Gregory Powell Koos Tech. Services

11:30
A New Phase Model for Sinusoidal Coding of Speech Signals

Sassan Ahmadi Arizona State Univ.
Andreas Spanias Arizona State Univ.



Chariot
MP1
Discrete Event Systems
Chair: C. G. Cassandras Boston Univ.
Chair: M. A. Christodoulou Tech. Univ. of Crete

1:30
Supervisory Control Using Computationally Efficient Linear
Techniques: A Tutorial Introduction

John O. Moody Univ. of Notre Dame
Panos J. Antsaklis Univ. of Notre Dame

2:00
Dynamic Resource Allocation in Discrete Event Systems

Christos G. Panayiotou Univ. of Massachusetts Amherst
Christos G. Cassandras Boston Univ.

2:30
Dynamic Neural Networks for Real-Time Manufacturing Cell
Scheduling

George A. Rovithakis Tech. Univ. of Crete
Vassilis I. Gaganis Tech. Univ. of Crete
Stelios E. Perrakis Tech. Univ. of Crete
Manolis A. Christodoulou Tech. Univ. of Crete

3:00
A State Reconstruction Algorithm for Parameter Dependent
Discrete Event Dynamic Systems

Francesco Martinelli Univ. di Roma Tor Vergata
Salvatore Nicosia Univ. di Roma Tor Vergata
Paolo Valigi Univ. di Roma Tor Vergata

3:30
A Model for Two-stage Manufacturing Systems

Wai Ki Ching Hong Kong Polyt. Univ.

Apollo
MP2
Nonlinear and Stochastic Control: Theory and Application
Chair: A. Lindquist Royal Inst. of Tech.
Chair: C. F. Martin Texas Tech Univ.
Org: A. Lindquist Royal Inst. of Tech.
Org: C. F. Martin Texas Tech Univ.

1:30
Dynamic Vision and Estimation Theory on Spheres

Giorgio Picci Univ. di Padova

2:00
Generalized Wiener-Hopf Factorization of Discrete-Time All-
Pass Functions

Gyorgy Michaletzky Eotvos Lorand Univ.

2:30
Observers for Systems with Implicit Output

A. Matveev St. Petersburg Univ.
X. Hu Royal Inst. of Tech.
R. Frezza Univ. di Padova

3:00
On the Covariance Extension Problem

Christopher I. Byrnes Washington Univ.
Anders Lindquist Royal Inst. of Tech.

3:30
Cross-Ratio Dynamics and its Applications to Calibration Free
Motion Estimation

Bijoy K. Ghosh Washington Univ.

4:00
Control of the Planar Rotation in Human Head-Eye-Coordina-
tion

Mangus Egerstedt Royal Inst. of Tech.
Clyde F. Martin Texas Tech Univ.



Zeus
MP3
Modeling Estimation and Control of Infinite Dimensional
Systems II
Chair: C. D. Charalambous McGill Univ.
Chair: S. Reich Technion-Israel Inst. of Tech.
Org: H. T. Banks North Carolina State Univ.
Org: M. A. Demetriou Worcester Polyt. Inst.

1:30
Inverse Problems for Nonautonomous Nonlinear Distributed
Parameter Systems

A. S. Ackleh Univ. of Southwestern Louisiana
S. Reich Technion-Israel Inst. of Tech.

2:00
A Conservative Spectral Element Method for the Approxima-
tion of Compressible Fluid Flow

Kelly Black Univ. of New Hampshire

2:30
Adaptive Identification of Distributed Parameter Systems

Yuri Orlov CICESE
Joseph Bentsman Univ. of Illinois Urbana-Champaign

3:00
Parameter Estimation in a Nonlinear Structured Tree Popula-
tion Model with Self Shading Effects

A. S. Ackleh Univ. of Southwestern Louisiana

Lindos
MP4
Control of Automotive Engines and Drivelines
Chair: H. P. Geering ETH Swiss Fed. Inst. of Tech.
Chair: L. Guzzella ETH Swiss Fed. Inst. of Tech.
Org: H. P. Geering ETH Swiss Fed. Inst. of Tech.
Org: L. Guzzella ETH Swiss Fed. Inst. of Tech.

1:30
Automated Design of an Air/Fuel Controller for an SI Engine
Considering the Three-way Catalytic Converter in the Hinf
Approach

C. A. Roduner ETH Swiss Fed. Inst. of Tech.
C. H. Onder ETH Swiss Fed. Inst. of Tech.
Hans. P. Geering ETH Swiss Fed. Inst. of Tech.

2:00
Feedback Linearization of a Multi-Input SI-Engine System for
Idle Speed Control

R. Pfiffner ETH Swiss Fed. Inst. of Tech.
Lino. Guzzella ETH Swiss Fed. Inst. of Tech.

2:30
Influence of Manifold Pressure Pulsation to Mean Value
Models in Air-to-Fuel Ratio Control

M. Scherer Daimler-Benz AG
C. Arndt Univ. of Siegen
O. Loffeld Univ. of Siegen

3:00
Modelling Internal Combustion Engines via Identification
Techniques

R. Scattolini Univ. di Pavia
G. De Nicolao Univ. di Pavia
M. Cittadini Univ. di Pavia
C. Rossi Magneti Marelli SpA
C. Siviero Magneti Marelli SpA

3:30
Identification of Emission Models in a Spark Ignition Engine for
Control Applications

I. Arsie Univ. di Salerno
C. Pianese Univ. di Salerno
G. Rizzo Univ. di Salerno

4:00
Advanced System Design and Control Aspects in a Fuel-
Optimal Hybrid Vehicle

E. Shafai ETH Swiss Fed. Inst. of Tech.
P. Dietrich ETH Swiss Fed. Inst. of Tech.
C. Wittmer ETH Swiss Fed. Inst. of Tech.
S. Ginsburg ETH Swiss Fed. Inst. of Tech.



5th  IEEE  MED
Tuesday,  July  22

Chariot
TA1
Intelligent Systems
Chair: K. P. Valavanis Univ. of Southwestern Louisiana
Chair: P. P. Groumpos Univ. of Patras

9:00
A State Configured Sensor Based Control Architecture for an
Autonomous Underwater Vehicle

Georgios. A. Demetriou Univ. of Southwestern Louisiana
Kimon P. Valavanis Univ. of Southwestern Louisiana

9:30
The Use of Fuzzy Cognitive Maps in Modeling Systems

Chrysostomos D. Stylios Univ. of Patras
Voula C. Georgopoulos Ohio Univ.
Peter P. Groumpos Univ. of Patras

10:00
Fuzzy Linear Programming and Simulated Annealing

Rita Almeida Ribeiro Univ. Nova Lisboa
Fernando Moura Pires Univ. Nova Lisboa

10:30
State Estimation in Presence of Disturbance Using Neural
Networks

B. Gaddouna Ouladsine Univ. Henri Poincare
Gerard  Bloch Univ. Henri Poincare

11:00
On-Line Neural Network Algorithm for the Constrained Motion
Planning of Redundant Manipulators

A. Ramdane-Cherif Univ. P. & M. Curie
D. Y. Meddah Univ. P. & M. Curie
V. Perdereau Univ. P. & M. Curie
M. Drouin Univ. P. & M. Curie

11:30
On the Selection of Nodes in Linear-in-the-Weight Neural
Networks

Elias B. Kosmatopoulos Univ. of Southern California
Nikitas J. Dimopoulos Univ. of Victoria

12:00
A Simplex Trained Neural Network-Based Architecture for
Sensor Fusion and Tracking of Target Maneuvers

Yee Chin Wong Univ. of Arizona
Malur K. Sundareshan Univ. of Arizona



Apollo
TA2
Robust Systems I
Chair: A. H. Sayed Univ. of California Los Angeles
Chair: M. Karkoub Kuwait Univ.

9:00
The Finite Inclusions Theorem: A Tool for Robust Design

Theodore E. Djaferis Univ. of Massachusetts Amherst

9:30
Every Mode Stabilization of Jump Linear Systems via LMIs

M. Ait Rami Ecole Nat. Sup. de Tech. Avancees

10:00
Robust Diagonal Stabilization and Finite Precision Problem: An
LMI Approach

Stephane Dussy Ecole Nat. Sup. de Tech. Avancees

10:30
Robust Quasi NID Aircraft 3D Fight Control Under Sensor
Noise

Marian J. Blachuta Silesian Tech. Univ.
Valery D. Yurkevich Novosibirsk State Tech. Univ.
Konrad Wojciechowski Silesian Tech. Univ.

11:00
Modeling And mu-Synthesis Robust Control of Two-Link
Flexible Manipulators

Mansour Karkoub Kuwait Univ.
Kumar Tamma Univ. of Minnesota

11:30
Exponentially-Weighted Iterative Solutions for Worst-Case
Parameter Estimation

Ali H. Sayed Univ. of California Los Angeles
Andrea Garulli Univ. di Siena
V. Nascimento Univ. of California Los Angeles
S. Chandrasekaran Univ. of California Santa Barbara

12:00
Some Issues on Robust Control for Nonlinear Systems

Michael Athans Massachusetts Inst. of Tech.
Alan Chao Massachusetts Inst. of Tech.

Zeus
TA3
Modeling Estimation and Control of Infinite Dimensional
Systems III
Chair: C. D. Charalambous McGill Univ.
Chair: S. Reich Technion-Israel Inst. of Tech.
Org: H. T. Banks North Carolina State Univ.
Org: M. A. Demetriou Worcester Polyt. Inst.

9:00
Optimal Location of Actuators for an Active Noise Control
Problem

F. Fahroo Naval Postgraduate School

9:30
Minimax Hinf Control of Stable Distributed Systems

O. Staffans Abo Akademi Univ.

10:00
Conditional Moment Generating Functions for Integrals and
Stochastic Integrals: Maximum-Likelihood Estimation

Charalambos. D. Charalambous McGill Univ.

10:30
Ergodic Boundary Control of Semilinear Systems

T. E. Duncan Univ. of Kansas



Lindos
TA4
Mobile Robots
Chair: P. Valigi Univ. di Roma Tor Vergata
Chair: T. Hamel Univ. De Tech. De Compiegne

9:00
A Robust-Adaptive Locomotion Controller for 9-Link Bipeds
with Rapidly Varying Unknown Parameters

S. G. Tzafestas National Tech. Univ. Athens
A. E. Krikochoritis National Tech. Univ. Athens
C. S. Tzafestas Univ. P. & M. Curie

9:30
An Assessment of Fuzzy Logic for Collision Avoidance in a
Multiple Autonomous Mobile Robot System

Chris G. Dodds The Univ. of Western Australia
Albert Y. Zomaya The Univ. of Western Australia

10:00
Steering of a Robotic Snake

K. Sarrigeorgides National Tech. Univ. Athens
K. J. Kyriakopoulos National Tech. Univ. Athens

10:30
Motion Planning for Drift-Free Nonholonomic Systems Under a
Discrete Levels Control Constraint

Photis G. Skiadas Univ. of Patras
Nick T. Koussoulas Univ. of Patras

11:00
Dynamic Modelling of a Tricycle Mobile Robot

Andre Kamga Univ. de Picardie Jules Verne

11:30
A Navigation System With Self-Localization Capabilities for an
Autonomous Mobile Robot

Alain Betourne Univ. di Roma Tor Vergata
Alessandro Fefe Univ. di Roma Tor Vergata
Salvatore Nicosia Univ. di Roma Tor Vergata
Paolo Valigi Univ. di Roma Tor Vergata

12:00
Practical Stability for Path-Following: A New Control Algorithm
for Mobile Robots

T. Hamel Univ. de Tech. de Compiegne
P. Soueres LAAS-CNRS
D. Meizel Univ. de Tech. de Compiegne



Chariot
TP1
Max-Algebra
Chair: Y. Wardi Georgia Inst. of Tech.
Chair: E. W. Kamen Georgia Inst. of Tech.
Org: E. Wagneur IRCyN/Ecole des Moines de Nantes

1:30
Linear Projectors in the Max-Plus Algebra

Guy Cohen INRIA
Stephane Gaubert INRIA
Jean-Piere Quadrat INRIA

2:00
Equivalence Classes of Rank-3 Matrices in the Max-Algebra

Jean-Michel Prou IRCyN/Ecole des Moines de Nantes
Edouard Wagneur IRCyN/Ecole des Moines de Nantes

2:30
Control Synthesis Approaches Using the State Equations and
the ARMA Model in Timed Event Graphs

Philippe Declerck ISTIA

3:00
Dynamic Control of Kanban System Over Dioid Algebra

B. Cottenceau LISA
L. Hardouin LISA
J.-L. Boimond LISA

3:30
Reachability and Observability of Linear Systems Over Max-
Plus

M. J. Gazarik Georgia Inst. of Tech.
Edward. W. Kamen Georgia Inst. of Tech.

4:00
Controllability in the Max-Algebra

Jean-Michel Prou IRCyN/Ecole des Moines de Nantes
Edouard Wagneur IRCyN/Ecole des Moines de Nantes

4:30
Nonexpansive Maps and Option Pricing Theory

Vassili Kolokoltsov  Nottingham Trent Univ.

Apollo
TP2
Robust Systems II
Chair: R. Hernandez-Berlinches UNED
Chair: E. Zeheb Technion-Israel Inst. of Tech.

1:30
Robust Stability Analysis of GPC: An Application to Dead-Beat
and Mean-Level Predictive Controllers

Roberto Hernandez-Berlinches UNED

2:00
Robust Stability of Non-Linear Time Varying Systems

Ezra Zeheb Technion-Israel Inst. of Tech.

2:30
Constrained Stabilization of a Dynamic System: A Case Study

Franco Blanchini Univ. degli Studi di Udine
S. Cotterli Eurotech
G. Koruza Univ. degli Studi di Udine
S. Miani Univ. degli Studi di Padova
R. Siagri Eurotech
L. Tubaro Univ. degli Studi di Udine

3:00
Robust and Reliable Hinf Output Feedback Control for Linear
Systems With Parameter Uncertainty and Actuator Failure

Chang-Jun Seo Inje Univ.
Byung Kook Kim KAIST

3:30
Quadratic Stabilizability of Uncertain Continuous-Time
Systems Under State and Control Constraints in the Presence
of Disturbances

H. X. de Araujo LAAS-CNRS
I. Queinnec LAAS-CNRS
S. Tarbouriech LAAS-CNRS

4:00
Delay-Dependent Robust Stability Tests and Decay Estimates
for Systems With Input Delays

Kostas Hrissagis Univ. of Florida, Gainsville
Olga I. Kosmidou Democritus Univ. of Thrace



Zeus
TP3
Linear Systems I
Chair: M. Sebek Inst. of Inform. Theory and Autom.
Chair: C. N. Hadjicostis Massachusetts Inst. of Tech.

1:30
Transfer Function Equivalence of Feedback/Feedforward
Compensators

Vladimir Kucera Academy of Sciences of the Czech Rep.

2:00
Numerical Operations Among Rational Matrices: Standard
Techniques and Interpolation

P. Husek Inst. of Inform. Theory and Autom.
Michael. Sebek Inst. of Inform. Theory and Autom.
J. Stecha Inst. of Inform. Theory and Autom.

2:30
Design of Fault-Tolerant LTI State-Space Systems

C. N. Hadjicostis Massachusetts Inst. of Tech.
G. C. Verghese Massachusetts Inst. of Tech.

3:00
An Integrated Framework for Input, Output and Control
Structure Selection: Advanced Control Diagnostics

N. Karcanias City Univ.
J. Leventides City Univ.
E. Milonidis City Univ.

3:30
System Zeros Analysis via SVD of the First Nonzero Markov
Parameter and the Kalman Decomposition Theorem

Jerzy Tokarzewski Military Univ. of Tech. Poland

4:00
Constrained Controllability of Dynamical Systems

Jerzy Klamka Tech. Univ. Poland

Lindos
TP4
Robot Control
Chair: A. Tornambe Terza Univ. di Roma
Chair: P. S. Shiakolas Univ. of Texas Arlington

1:30
Global Asymptotic Stabilisation of an Active Mass Damper for
a Flexible Beam

Laura. Menini Univ. di Roma Tor Vergata
Antonio. Tornambe Terza Univ. di Roma
L. Zaccarian Terza Univ. di Roma

2:00
Variable Structure Control of a Robotic Assistance System

M. L. Corradini Univ. di Ancona
T. Leo Univ. di Ancona
G. Orlando Univ. di Ancona

2:30
Control of Robot Manipulators Using CMAC Neural Networks

S. Commuri CGN & Associates
S. Jagannathan Automated Analysis Corp.
F. L. Lewis Univ. of Texas at Arlington

3:00
On the Development of a Quick Connect Disconnect Coupler
for Rapidly Configured Modular Robots

P. S. Shiakolas Univ. of Texas Arlington
T. W. Sharpe Univ. of Texas Arlington
T. J. Lawley Univ. of Texas Arlington

3:30
Robot Control Using a Sliding Mode

M. Belhocine Centre de Dev. des Tech. Avances
M. Hamerlain Centre de Dev. des Tech. Avances
K. Bouyoucef Centre de Dev. des Tech. Avances
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Chariot
WA1
Nonlinear Systems
Chair: J. S. Shamma Univ. of Texas Austin
Chair: M. M. Polycarpou Univ. of Cincinnati

9:00
Set-Valued State Observers for Nonlinear Systems

Jeff S. Shamma Univ. of Texas Austin
Kuang-Yang Tu Univ. of Texas Austin

9:30
State Observers for Nonlinear Systems With Smooth/Bounded
Input

A. Germani Univ. degli studi dell Aquila
C. Manes Univ. degli studi dell Aquila

10:00
Parameter Identification of Nonlinear Systems With Known
Structure

Alessandro Astolfi Imperial College
J. J. Milek ETH Swiss Fed. Inst. of Tech.
F. J. Kraus ETH Swiss Fed. Inst. of Tech.

10:30
Design and Analysis of Incipient Fault Diagnosis Schemes
Using On-Line Approximators

Marios M. Polycarpou Univ. of Cincinnati
Michael A. Demetriou Worcester Polyt. Inst.

11:00
On Feedback Linearization Solution

M. Hou Loughborough Univ.
A. C. Pugh Loughborough Univ.

11:30
On Singular Phenomena in Certain Time-Optimal Feedback
System Operating by Discontinuous Resistance

Wladyslaw Hejmo Cracow Univ. of Tech.

12:00
Emergency Control of Unstable Behavior of Nonlinear Systems
Induced by Fault

Mark A. Pinsky Univ. of Nevada Reno
Michael V. Basin Univ. of Nevada Reno



Apollo
WA2
Applications
Chair: N. Denis Univ. of Massachusetts Amherst
Chair: C. Vaucoret ENSICA/DFR/AS

9:00
A Symbolic Sensor for an Antilock Brake System of a Commer-
cial Aircraft

B. Ewers ENSICA/DFR/AS
J. Bordeneuve-Guibe ENSICA/DFR/AS
Corinne Langlois Aerospatiale

9:30
Multivariable Predictive Controller for a Test Stand of Air
Conditioning

Cyril Vaucoret ENSICA/DFR/AS
Joel Bordeneuve-Guibe ENSICA/DFR/AS

10:00
Hinf Control Design For an Adaptive Optics System

Nikolaos Denis Univ. of Massachusetts Amherst
Douglas. Looze Univ. of Massachusetts Amherst
Jim Huang Alphatech
David Castanon Boston Univ.

10:30
Optimal Fixture Design for Drilling in Elastically Deforming
Plates

K. Wardak Univ. of Maryland BC
U. Tasch Univ. of Maryland BC
P. G. Charalambides Univ. of Maryland BC

11:00
Development of Mold Level Controller Using Sliding Mode
Control in a Continuous Casting Processing

Seung Ryeol Yoo Tech. Research Lab. POSCO
Young Seub Kueon Tech. Research Lab. POSCO

11:30
Modeling and Simulation of a Blood Pump for Controller
Development

Yih-Choung Yu Univ. of Pittsburgh
James F. Antaki Univ. of Pittsburgh
J. Robert Boston Univ. of Pittsburgh
Marwan Simaan Univ. of Pittsburgh
Phil J. Miller Baxter Healthcare

12:00
The Control and Structures Research Laboratory (CSRL): A
Control-Oriented Test-Bed for Large Segmented Reflectors

Majdedin Mirmirani California State Univ. Los Angeles
Helen R. Boussalis California State Univ. Los Angeles
Khosrow Rad California State Univ. Los Angeles
Mohiuddin Ahmed California State Univ. Los Angeles
Anastasios Chassiakos California State Univ. Long Beach
Petros Ioannou Univ. of Southern California
Elias Kosmatopoulos Univ. of Southern California



Zeus
WA3
Linear Systems II
Chair: P. G. Voulgaris Univ. of Illinois Urbana-Champaign
Chair: B. Kouvaritakis Univ. of Oxford

9:00
l1-Optimal Control for Multirate Systems Under Full State
Feedback

Johannes Aubrecht Univ. of Illinois Urbana-Champaign
Petros G. Voulgaris Univ. of Illinois Urbana-Champaign

9:30
Ellipsoidal Bounding in Stable Predictive Control

M. Cannon Univ. of Oxford
B. Kouvaritakis Univ. of Oxford

10:00
Constrained Stable Predictive Control: An l2-Optimal Approach

B. Kouvaritakis Univ. of Oxford
J. A. Rossiter Loughborough Univ.
M. Cannon Univ. of Oxford

10:30
The Performance of Generalized Minimum Variance System
Identification

Odell R. Reynolds Air Force Inst. of Techn.
Meir Pachter Air Force Inst. of Techn.

11:00
Weighted Hinf Mixed-Sensitivity Minimization for Stable
Distributed Parameter Plants Under Sample-Data Control

Delano R. Carter Arizona State Univ.
Armando A. Rodriguez Arizona State Univ.

11:30
On Sample-Data Control Systems With Discontinuous Output

Marian J. Blachuta Silesian Tech. Univ.

Lindos
WA4
Automotive Systems
Chair: P. Ioannou Univ. of Southern California
Chair: R. Majjad Univ. of Karslruhe

9:00
Macroscopic Traffic Flow Modeling of Automated Highway
Systems

H. Raza Univ. of Southern California
Petros. Ioannou Univ. of Southern California

9:30
Robust Prevention of Limit Cycles for Robustly Decoupled Car
Steering Dynamics

Juergen Ackermann DLR
Tilman Buente DLR

10:00
Modular Design for the Computation of Vehicle Dynamic
Behavior

R. Majjad Univ. of Karslruhe
U. Kiencke Univ. of Karslruhe

10:30
Identification of Parameters for Complex Vehicle Models

R. Majjad Univ. of Karslruhe
M. Hafner Univ. of Karslruhe

11:00
Application Car Dynamics Model

Said. Bentalba Univ. de Picardie-Jules Verne
A. El Hajjaji Univ. de Picardie-Jules Verne
A. Rachid Univ. de Picardie-Jules Verne

11:30
Sliding Mode Control of a Turbocharged Diesel Engine

S. Ouenou-Gamo Univ. de Picardie Jules Verne
A. Benchaib Univ. de Picardie Jules Verne
A. Rachid Univ. de Picardie Jules Verne
M. Ouladsine Univ. de Picardie Jules Verne



Chariot
WP1
Two-Dimensional Systems
Chair: N. E. Mastorakis Hellenic Naval Academy
Chair: N. Denis Univ. of Massachusetts Amherst

1:30
A New Method for Computing the Stability Margin for Two-
Dimensional Systems

Nikos E. Mastorakis Hellenic Naval Academy

2:00
New Stability Test for 2-D Systems

Nikos E. Mastorakis Hellenic Naval Academy

2:30
Reachability and Minimum Energy Control of Nonnegative 2-D
Roesser Type Models

Tadeusz Kaczorek Warsaw Univ. of Tech.

3:00
Some Results on the Dynamics of 2D Positive Systems

Ettore Fornasini Univ. di Padova
Maria Elena Valcher Univ. di Padova

Apollo
WP2
Adaptive Control
Chair: I. Kanellakopoulos Univ. of California Los Angeles
Chair: R. L. Kosut SC Solutions

1:30
Adaptive Control of Discrete-Time Output-Feedback Nonlinear
Systems

Jiaxiang Zhao Univ. of California Los Angeles
Ioannis Kanellakopoulos Univ. of California Los Angeles

2:00
An Uncertainty Model Validation Approach to Adaptive Robust
Linear Control

Robert L. Kosut SC Solutions

2:30
Application of a Multivariable Adaptive Controller With PID
Structure to a Wastewater Treatment Plant With D-N Configura-
tion

A. M. Macarulla CEIT
J. Florez CEIT
J. X. Ostolaza CEIT
E. Ayesa CEIT

3:00
Adaptive Variable Structure Control of Robot Manipulators With
Exponentially Stable Trajectories

Hongnian Yu Liverpool John Moores Univ.



Zeus
WP3
Linear Systems III
Chair: V. L. Syrmos Univ. of Hawaii Manoa
Chair: R. Drai Ecole des Mines de Paris

1:30
Normalized Coprime Factorizations for Discrete-Time Periodic
Systems

Baohui Xie Univ. of Hawaii Manoa
Vassilis L. Syrmos Univ. of Hawaii Manoa

2:00
The Tracking and Regulation Problem for a Class of
Generalised Systems

Antonio Tornambe Terza Univ. di Roma

2:30
Dynamic Output Feedback Stabilization for a Class of Satu-
rated Linear Systems

M. Klai IGE
Y. Ait-Amirat IGE

3:00
Stabilization Independent of Delay for Saturated Linear
Systems

M. Klai IGE
Y. Ait-Amirat IGE

3:30
Design of L. Q. G. Dissipative Controllers Using Linear Matrix
Inequalities

Remi Drai Ecole des Mines de Paris

Lindos
WP4
Digital Signal Processing II
Chair: C. N. Georghiades Texas A & M Univ.
Chair: A. Spanias Arizona State Univ.

1:30
An Application of the EM Algorithm to Sequence Estimation in
the Presence of Tone Interference

Quan G. Zhang Texas A & M Univ.
Costas N. Georghiades Texas A & M Univ.

2:00
A Non-Linear Filtering Algorithm for the Measurement of
Rainfall Drop Size Distribution

Takis Kasparis Univ. of Central Florida
John Lane Univ. of Central Florida

2:30
Invariant Line Matching of Consecutive Images

Djemaa Kachi Univ. de Tech. de Compiegne
Xiao-Wei Tu Univ. de Tech. de Compiegne



MA1 Hybrid Systems

    MA1-1

Automation Comparison Procedure for the Verification of Hybrid Systems

Wolf Kohn, Jeffrey B. Remmel, Anil Nerode

Abstract

This paper describes on-going research on a procedure for the verification of Hybrid System Controllers implemented
with the Kohn-Nerode extraction procedure, [8, 10, 12], implemented by the Multiple Agent Hybrid Control Architec-
ture (MAHCA) [11].  It is an automated static verification technique based on the construction of an Intersection
Unification Automaton (IUA).  Given a hybrid system controller generated by a MAHCA agent and a set of control
specifications for its desired behavior, the proposed verification procedure builds an IUA constructed by an automata
operation on two inference automata: the automaton encoding the specifications and the control automaton con-
structed by the inferencer of the agent [11].  The ultimate goal of our research is to develop a verification procedure to
verify a MAHCA distributed implementation to a set of global requirement specifications.  In this paper we discuss an
essential step, namely a procedure to verify that the controller design generated by an agent in MAHCA meets the
requirements established for that agent.  The paper describes the functionality of the procedure and illustrates it with
an example.



MA1 Hybrid Systems

MA1-2

A Hybrid System Approach to Feedback Control of a Nonholonomic Vehicle

J. Almeida, F. Lobo Pereira, J. Borges Sousa

Abstract

This paper addresses the design of a hybrid feedback control system enabling a car-like, rectangular vehicle to per-
form a tight L-shaped turn maneuver.  This case constitutes an effort towards the definition of a general purpose
methodology for hybrid feedback control synthesis.  The design effort encompasses the synthesis of a set of modali-
ties and mechanisms to detect relevant events enabling the overall motion coordination so that a global goal is at-
tempted.  Simulations of the implemented controller have shown a strong robustness with respect to modeling uncer-
tainty and execution errors.
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     MA1 Hybrid Systems   

    MA1-3

Discrete Levels Control of Nonlinear Systems

Photis G. Skiadas, Nick T. Koussoulas

Abstract

We study an interesting issue arising in digital implementation and hybrid control systems frameworks, namely what are
the basic characteristics of the behavior of a nonlinear dynamic system when it is driven by input that can assume only
discrete levels.  In particular, we focus on the controllability of nilpotent systems with and without drift, whose inputs take
values in a finite discrete level set.  In both cases, we prove that the constrained system and the corresponding
unconstrained system have the same accessibility and controllability properties.  An application of these results in motion
planning for nonholonomic systems appears in a companion paper.



 MA1 Hybrid Systems

 MA1-4

A Framework for Hybrid Control Design and its Relations with a Class of Fuzzy Logic Control
Systems

R. Fierro, F. L. Lewis, K. Liu

Abstract

This paper presents a Hybrid System Framework which considers simultaneously the lower-level control and deci-
sion-making issues.  This reconfigurable framework can accommodate a wide range of situations, from aircraft con-
trol systems to mobile manipulators.  A continuous-state plant is supervised by a discrete-event system which is based
on a theory of linked finite state machines.  The composite system is viewed as an iterative process where a task is
carried out by changing the structure of the continuous-state plant.  An application of this framework is illustrated
through a mobile manipulator example.  Finally, some connections between hybrid systems and a class of fuzzy logic
control systems are established.



MA2 Stochastic Systems

    MA2-1

Estimation of Hidden Markov Models for Partially Observed Risk Sensitive Control Problems

Bernard Frankpitt, John Baras



 MA2 Stochastic Systems

MA2-2

Linear Gaussian Quadratic Regulation under Poisson Distributed Intermittent State Observa-
tions

M. Ades, P. E. Caines, R. P. Malhame



 MA2 Stochastic Systems

 MA2-3

Finite-Dimensionality of Information States in Optimal Control of Stochastic Systems

Charalambos D. Charalambous

Abstract

This paper is concerned with partially observed stochastic optimal control problems.  The state of the system is
described by a nonlinear controlled diffusion equation.  The measurement are noisy linear combinations of the state,
and the rate of change of the sate of the system.  Explicit representations for the information state are derived in terms
of a finite-number of sufficient statistics.  This allows application of Wonham’s classical separation theorem.



MA2 Stochastic Systems

 MA2-4

Tracking Changing Stochastic Models via Stochastic Binary Neural Networks

Anthony Burrell, Achilles Kogiantis, P. Papantoni-Kazakos

Abstract

We consider a sequential algorithm that detects changes from an acting stochastic model to any one of a number of
alternatives.  We adopt discrete approximations of the stochastic models and we propose the deployment of stochastic
binary neural networks which are pretrained to produce the appropriate statistical measures associated with these
models.  The pretraining is implemented by a backpropogating supervised learning algorithm of stochastic approxi-
mation nature which converges almost surely under general conditions.  The overall system performance is discussed
and some numerical results are presented.



MA3 Modeling Estimation and Control of Infinite Dimensional Systems I

    MA3-1

Spray Control

A. El Jai



 MA3 Modeling Estimation and Control of Infinite Dimensional Systems I

 MA3-2

Estimation and Control of Sample-Data Systems in Infinite Dimensions

Akira Ichikawa



MA3 Modeling Estimation and Control of Infinite Dimensional Systems I

MA3-3

Fault Accommodation of Output-Induced Actuator Failures for a Flexible Beam with Collocated
Input and Output

Michael A. Demetriou, Marios M. Polycarpou

Abstract

In this note, we propose a nonlinear on-line parameter estimation method that utilizes neural network-based
approximators for detecting changes due to actuator faults in a class of structured dynamical systems.  The plant
considered here is a cantilevered beam actuated via a pair of piezoceramic patches.  We examine changes in the
control input term, which provide a simple and practical model of actuator failures.  Using Lyapunov redesign meth-
ods, a stable learning scheme is utilized in a control reconfiguration in order to accommodate the system's actuator
failure.  A numerical algorithm is provided for the implementation of the detection and accommodation scheme and
simulation studies are used to illustrate the applicability of the theoretical results.



 MA3 Modeling Estimation and Control of Infinite Dimensional Systems I

MA3-4

Sampled Weighted Attraction Control of Distributed Thermal Scan Welding

Charalambos C. Doumanidis



MA4 Digital Signal Processing I

    MA4-1

Algorithms for Phase Acquisition for QAM Constellations

Costas N. Georghiades

Abstract

Because of their relatively good performance, large QAM constellations are being used in many current communica-
tion applications.  One of the problems associated with the use of large QAM constellations is that of carrier acquisi-
tion, which for efficiency reasons must often be done without the use of preamble.  The problem is further complicated
for cross constellations, for which the high SNR corner points used by some simple carrier phase estimators are not
available.  In this paper we derive simple algorithms for carrier phase acquisition that can be used for both square and
cross constellations, and compare their performance to that of the 4-th power estimator.  The introduced algorithms
convert the problem of carrier phase estimation into one of estimating the mode of an underlying distribution.



 MA3 Modeling Estimation and Control of Infinite Dimensional Systems I

 MA4-2

Maximum Likelihood Estimation of Scale

John A. Stuller

Abstract

This paper introduces the solution to the problem of maximum likelihood (ML) scale estimation.  The result is ob-
tained using coupled Karhunen-Loeve expansions, which were recently introduced in [1-3] to solve the problem of
ML displacement (or time delay) estimation.  The coupled Karhunen-Loeve expansions lead directly to intuitively
reasonable signal processors associated with ML displacement and ML scale estimation.  Simulations results that
demonstrate the performance of ML scale estimation are included in this paper.



 MA3 Modeling Estimation and Control of Infinite Dimensional Systems I

 MA4-3

A Novel BPSK Demodulator Using the Expectation Maximization Algorithm

Takis Kasparis, Gregory Powel

Abstract

A novel coherent demodulator is proposed which utilizes the expectation-maximization (EM) algorithm for carrier
phase recovery.  The EM algorithm is feed-forward, and therefore produces no carrier phase error to be fed back to the
down conversion process.  The algorithm produces a maximum likelihood estimate of the modulating bit sequence,
given the received in-phase and quadrature-phase data.  Previously, the EM algorithm has been used to demodulate
Binary Phase Shift Keying (BPSK) modulated signals, but assumed perfect symbol synchronization.  This work
combines the EM algorithm with a symbol timing estimation (TE) algorithm to produce a complete BPSK demodula-
tor.  The results of the TE algorithm are used to control a polyphase matched filter, which performs root-raised cosine
matched filtering as well as symbol timing correction.  Simulation results show that the proposed demodulator per-
forms within 1 dB of theory, given constant carrier phase error and/or constant symbol timing error.  The demodula-
tion performs within 0.75 dB of theory given a carrier frequency offset of 1.5% of the symbol rate.



 MA3 Modeling Estimation and Control of Infinite Dimensional Systems I

MA4-4

A New Phase Model for Sinusoidal Transform Coding of Speech Signals

Sassan Ahmadi, Andreas S. Spanias

Abstract

A new phase modeling algorithm for sinusoidal analysis/synthesis of speech is presented. Short-time sinusoidal phases
are approximated using a combination of linear prediction, spectral sampling, delay compensation and phase correc-
tion techniques.  The algorithm is different than phase compensation methods proposed for source-system LPC in that
it has been optimized for sinusoidal representation of speech.  Performance analysis on a large speech database indi-
cates considerable improvement subjective quality of the reconstructed speech.  The extra parameter used for repre-
sentation of the sine wave phases require a small number of bits.  The method can be applied to enhance phase
matching in low-bit rate sinusoidal coders, where underlying sine wave amplitudes are extracted from an all-pole
model.



MP1 Discrete Event Systems

    MP1-1

Supervisory Control Using Computationally Efficient Linear Techniques:
A Tutorial Introduction

John O. Moody, Panos J. Antsaklis

Abstract

This paper provides an overview of a computationally efficient method for synthesizing supervisory controllers for
discrete event systems (DES).  The DES plant and controller are described by Petri nets which provide a useful linear
algebraic model for both control analysis and synthesis.  It is shown how a set of linear constraints on the plant's
behavior can be enforced, accounting for possibly uncontrollable or unobservable transitions in the plant net, using
techniques from Petri net theory, integer programming, and linear systems.  The paper is written as a tutorial introduc-
tion to the approach.  Several results here have been reported elsewhere in the literature.



 MP1 Discrete Event Systems

MP1-2

Dynamic Resource Allocation in Discrete Event Systems

Christos G. Panayiotou, Christos G. Cassandras

Abstract

In this paper we develop a controller for dynamic resource allocation in Discrete Event Systems (DES) operating in a
stochastic environment.  The controller's objective is to allocate a finite number of discrete resources to a set of users
so as to achieve optimal systems performance.  The derived controller uses concurrent estimation, a sample path
constructability technique for DES, to obtain estimates of the system's performance under a set of hypothetical param-
eter settings using only information observed from the real system.  Subsequently, these estimates are used by an on-
line algorithm which reallocates the resources among the various users to achieve our objective.  An application to a
buffer allocation problem is included along with explicit numerical results illustrating the use of this dynamic alloca-
tion scheme.



MP1 Discrete Event Systems

 MP1-3

Dynamic Neural Networks for Real-Time Manufacturing Cell Scheduling

George A. Rovithakis, Vassilis I. Gaganis, Stelios E. Perrakis, Manolis A. Christodoulou

Abstract

In this paper, a control aspect of the non-acyclic FMS scheduling problem is considered.  Based on a dynamic neural
network model derived herein, an adaptive, continuous time neural network controller is constructed.  The actual
dispatching times are determined from the continuous control input discretization.  The controller is capable of driv-
ing system production to the required demand and guaranteeing system stability and boundedness of all signals in the
closed loop system.  Modeling errors and discretization effects are taken into account thus rendering the controller
robust.  A case demonstrates the efficiency of the proposed technique.



MP1 Discrete Event Systems

 MP1-4

A State Reconstruction Algorithm for Parameter Dependent Discrete Event Dynamic Systems

Francesco Martinelli, Salvatore Nicosia, Paolo Valigi

Abstract

In this paper, the problem of state reconstruction for the class of parameter dependent discrete event systems that
can be modeled by means of queuing networks is considered, and a novel solution is proposed, based on the use of
data extracted from the observation of a real system.  The algorithm allows to accurately reconstruct the state
behavior of a queuing network, for values of the parameters of the system different from the nominal ones.  The
proposed approach has been applied to the on-line control problems for real systems, and a complete control
procedure is proposed.



 MP1 Discrete Event Systems

 MP1-5

A Model for Two-stage Manufacturing Systems

Wai Ki Ching

Abstract

This paper studies a two-stage (two machines in tandem) manufacturing systems under hedging point production
policy.  The manufacturing system produces one type of product and its demand is modeled as a Poisson process.
Each product has to go through the manufacturing process by a reliable machine in each stage.  Preconditioned
Conjugate Gradient (PCG) method is employed to solve the steady state probability distribution of systems.
Preconditioner is constructed by taking circulant approximation of the generator matrix of the system.  We prove that
the preconditioned linear system has singular values clustered around one when the number of inventory levels tend to
infinity.  Hence conjugate gradient methods will converge very fast when apply to solving the preconditioned linear
system.  Numerical examples are given to verify our claim.  The average running cost can be written in terms of this
probability.  By varying different possible values of hedging point h, the optimal value of h which minimizes the
average running cost can be obtained.  Extension to multiple parallel machines in each stage is also discussed.



MP2 Nonlinear and Stochastic Control: Theory and Application

    MP2-1

Dynamic Vision and Estimation Theory on Spheres

Giorgio Picci



 MP2 Nonlinear and Stochastic Control: Theory and Application

  MP2-2

Generalized Wiener-Hopf Factorization of Discrete-Time All-Pass Functions

Gyorgy Michaletzky



MP2 Nonlinear and Stochastic Control: Theory and Application

    MP2-3

Observers for Systems with Implicit Output

A. Matveev, X. Hu, R. Frezza

Abstract

In this paper we consider a system whose output is implicitly defined.  The system is assumed to be Lyapunov stable
but not asymptotically stable.  The problem we consider is to construct a dynamical observer.  This system is some-
how similar to a linear time-varying system.  However, the difference is that the C matrix varies with output here.  As
far as we know, even for linear time-varying systems, constructing an observer is far from trivial.



MP2 Nonlinear and Stochastic Control: Theory and Application

   MP2-4

On the Covariance Extension Problem

Christopher I. Byrnes, Anders Lindquist



 MP2 Nonlinear and Stochastic Control: Theory and Application

 MP2-5

Cross-Ratio Dynamics and its Applications to Calibration Free Motion Estimation

Bijoy K. Ghosh
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  MP2-6

Control of the Planar Rotation in Human Head-Eye-Coordination

Magnus Egerstedt, Clyde F. Martin

Abstract

In this article, the problem of how to model and control the combined motion of the human head and eye is being
investigated.  Based on a simplified physical model and an assumption that the muscles can be modeled as damped
springs with a second order linear dynamics, we derive models, for which we then can find control laws that both
make the combined pupil-movement follow a given trajectory, and make the separate head eye trajectories three times
continuously derivable.  Our control also make the energy produced in the movement small, since we believe that to
be a reasonable, physical control-criterion. We also investigate what role time delay plays when it comes to switching
between active and inactive muscles.



 MP3 Modeling Estimation and Control of Infinite Dimensional Systems II

 MP3-1

Inverse Problems for Nonautonomous Nonlinear Distributed Parameter Systems

Azmy S. Ackleh, Simeon Reich

Abstract

We will consider inverse problems involving the identification of time dependent, nonlinear, distributed parameter
systems.  A general convergence result for parameter estimates obtained using Galerkin approximations is presented.
The application of our theory to an example is discussed.



 MP3 Modeling Estimation and Control of Infinite Dimensional Systems II

  MP3-2

Minimax H-Infinity Control of Stable Distributed Systems  

Kelly Black



MP3 Modeling Estimation and Control of Infinite Dimensional Systems II

   MP3-3

Adaptive Identification of Distributed Parameter Systems

Yuri Orlov, Joseph Bentsman

Abstract

This work presents synthesis of adaptive identifiers for distributed parameter systems (DPS) described by partial
differential equations (PDE's) of parabolic, elliptic, and hyperbolic type.  The novel feature of the identification
algorithms presented is the lack of a need for computing second spatial derivatives for the cases of several unknown
parameters.  This feature makes the algorithms much more applicable in the presence of measurement nonlinearities.
The fundamental concept of identifiability is studied.  Adjustable parameters in the adaptive identifiers proposed are
shown to admit simultaneous convergence to their nominal space-varying values when an appropriate input signal is
used.  The class of sufficiently rich input signals referred as generators of persistent excitation is defined.  This class
guarantees the existence of a unique zero steady state for the parameter errors, thereby yielding unknown plant param-
eters.



MP3 Modeling Estimation and Control of Infinite Dimensional Systems II

   MP3-4

Parameter Estimation in a Nonlinear Structured Tree Population Model With Self Shading
Effects

Azmy S. Ackleh

Abstract

We discuss a least square method for identifying the growth function in a nonlinear hyperbolic initial-boundary value
problem that describes the dynamics of tree population with self shading effects.  Furthermore, we present numerical
results of estimating this parameter from computationally generated data.
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    MP4-1

Automated Design of an Air/Fuel Controller for an SI Engine Considering the Three-way Cata-
lytic Converter in the Hinf approach

C. A. Roduner, C. H. Onder, H. P. Geering

Abstract

The correct operation of the emissions reduction system of an SI engine depends on the capability of the three-way
catalyst (TWC) to store and release oxygen.  Either one or the other is lost if the oxygen storage of the TWC is
completely full or completely empty.  In order to optimally handle upstream air-to-fuel ratio (lambda) excursions in
either direction (lean or rich), the stored oxygen mass should be kept near the middle of the current oxygen storage
capacity.  An Hinf controller is developed which takes into account the dynamic behavior of the TWC.  The main
design goal is to compensate the disturbance impact on the relative oxygen storage level by first measuring the
upstream air-to-fuel ratio only.  For this purpose the TWC is regarded as a limited integrator.  The dynamics of the
fuel-path subsystem of the engine (between fuel injection and measured upstream air-to-fuel ratio) is modeled by
lowpass element and a time delay connected in series.  Since the measurements on an engine test bench illustrate the
performance of the control system.



MP4 Control of Automotive Engines and Drivelines

    MP4-2

Feedback Linearization of a Multi-Input SI-Engine System for Idle Speed Control

R. Pfiffner, L. Guzzella

Abstract

The idle speed control problem is a classical example of an automotive control application.  The set-up corresponds to
a disturbance rejection problem where the main plant output (engine speed) has to be maintained at a (low) constant
value despite the torque disturbances acting on the engine crank-shaft (servo-steering pump, air-conditioning com-
pressor etc.).  The relevance (comfort, fuel consumption etc.) and the technical challenges (nonlinear plant with large
time delays and uncertainties) of this control problem have led to many different control strategies.  PID, LQ, Hinf,
fuzzy control, adaptive control, sliding mode and neural networks are some of the frameworks used to tackle this
problem.  Feedback linearization was also investigated in some papers, but the engine's induction power stroke delay
was neglected.  Unfortunately, this effect, that depends in addition on the engine speed, is often the limiting factor for
the controller design.  For this reason in the here presented work, this delay is approximated with a cascade of two first
order low pass elements, which have engine-speed dependent time constants.  The resulting nonlinear fourth order
plant with two inputs (air bypass valve and spark advantage) is not affine in both inputs.  Nevertheless, by introducing
additional static compensations the plant is shown to be exactly feedback linearizable.  The linearized plant permits
the application of well-known linear control design methods. In this paper the different bandwidths of the two inputs
are used in an Hinf design to guarantee an optimal engine operation both under transient and steady-state conditions.



MP4 Control of Automotive Engines and Drivelines

    MP4-3

Influence of Manifold Pressure Pulsation to Mean Value Models in Air-to-Fuel Ratio Control

M. Scherer, C. Arndt, O. Loffeld



MP4 Control of Automotive Engines and Drivelines

    MP4-4

Modelling Internal Combustion Engines via Identification Techniques

R. Scattolini, G. De Nicolao, M. Cittadini, C. Rossi, C. Siviero

Abstract

This paper deals with the identification of NARX (Nonlinear Autoregressive eXogeneous) models for describing the
pressure inside the intake manifold and the crankshaft speed of Internal Combustion car engines.  The proposed
method is based on stepwise regression and has been applied to real data collected on a 1200 cm3 commercial engine.
A number of experimental results witness the applicability of the approach.



MP4 Control of Automotive Engines and Drivelines

    MP4-5

Identification of Emission Models in a Spark Ignition Engine for Control Applications

I. Arsie, C. Pianese, G. Rizzo



MP4 Control of Automotive Engines and Drivelines

    MP4-6

Advanced System Design and Control Aspects in a Fuel-Optimal Hybrid Vehicle

E. Shafai, P. Dietrich, C. Wittmer, S. Ginsburg

Abstract

Electric vehicles today clearly represent the only solution fulfilling the zero emission vehicles (ZEV) standard.  How-
ever, they still are not an equivalent alternative to the gasoline driven cars due to the well known problems of today's
batteries.  The concept of a parallel hybrid drive line can be an optimal combination of both principles of propulsion
in that the gasoline engine guarantees for a wide range of operation, while the electric propulsion can be used within
the restricted zero emission zones.  The parallel hybrid solution described here has been realized in the "Hybrid III"
research and development project at the Swiss Federal Institute of Technology (ETH), Zurich, Switzerland.  The drive
line consists of a gasoline engine, an electric asynchronous motor/generator, a flywheel, and a wide range continu-
ously variable transmission.  It is shown how these components cooperate in a fuel-optimal way.  This drive line is
now about to be integrated in a vehicle for real road testing.  This paper describes the experimental results on a
dynamic test bench verifying its operation under realistic traffic conditions.



TA1 Intelligent Systems

    TA1-1

A State Configured Sensor Based Control Architecture for an Autonomous Underwater Vehicle

G. A. Demetriou, K. H. Valavanis

Abstract

A new embedded control system hardware and software control architecture suitable for an AUV is presented.  The
proposed scheme is based on the shared memory principle and consists of three components, a supervisory controller,
a functional and a hardware/execution component.  Off-the-shelf technology has been used to build and implement the
described AUV control architecture.  Key features of the proposed architecture include: autonomy, learning, recovery,
multiple goals in a single mission, use of multiple sensors for data collection.  This embedded architecture is modular,
reconfigurable, expandable and cost-effective.



TA1 Intelligent Systems

 TA1-2

The Use of Fuzzy Cognitive Maps in Modeling Systems

Chrysostomos D. Stylios, Voula C. Georgopoulos, Peter P. Groumpos

   Abstract

This paper investigates a new theory, Fuzzy cognitive Map (FCM) Theory, and its implementations in modeling
systems.  First the description and the methodology that this theory suggests is examined and then the application of
FCM in a process control problem is described.  The presentation indicates how powerful FCMs are and some inter-
esting points for further research are included.  In the recent years, a wide discussion has started about the autonomy
and intelligence of systems, so the application of FCM in the field of control and systems may contribute in the
development of more intelligent and autonomous control systems.



TA1 Intelligent Systems

 TA1-3

Fuzzy Linear Programming and Simulated Annealing

Rita  Almeida Ribeiro, Fernando Moura Pires

Abstract

This paper shows how the simulated annealing (SA) algorithm provides a simple tool for solving fuzzy optimization
problems.  Often, the issue is not so much how to fuzzify or remove the conceptual imprecision, but which tools
enable simple solutions for these intrinsically uncertain problems.  A well-known linear programming example is
used to discuss the suitability of the SA algorithm for solving fuzzy optimization problems.
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 TA1-4

State Estimation in Presence of Disturbance Using Neural Networks

B. Gaddouna Ouladsine, G. Bloch

Abstract

A state reconstruction method of non-linear systems is proposed.  It concerns the systems which can be decomposed
into linear and non-linear parts and requires the implementation of two observers.  The first one is used for determin-
ing approximately the target of a neural network providing the estimation of the nonlinearity.  This one can be the
consequence of modeling errors of the system parameters.  The second one allows to reconstruct the state of the
nonlinear system.
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 TA1-5

On-Line Neural Network Algorithm for the Constrained Motion Planning of Redundant Ma-
nipulators

A. Ramdane-Cherif, D. Y. Meddah, V. Perdereau, M. Drouin

Abstract

In this paper, we propose an iterative method using a neural network to solve the inverse kinematic problem for
redundant manipulators in presence of motion constraints such as joint limits or obstacles.  A constrained optimization
scheme with penalty functions based on neural network is formulated.  The neural network is adapted in the direction
of decreasing a Lyapunov function to move the end-effector to the desired position while avoiding a collision with
respectively a workspace object and a contact environment surface.  This approach offers substantially better accuracy
and avoids the computation of the inverse or pseudoinverse Jacobian matrix.  The application of this scheme to a 3
degrees of freedom redundant manipulator is demonstrated through simulation results.



TA1 Intelligent Systems

TA1-6

On the Selection of Nodes in Linear-in-the-Weight Neural Networks

Elias B. Kosmatopoulos, Nikitas J. Dimopoulos

Abstract

Linear-in-the-weights neural networks are known to possess certain advantages over classical multilayer neural net-
works. In the past, there have been many learning algorithms proposed for training linear-in-the-weights neural net-
works [12, 8, 9, 10]; among the nice properties of those algorithms are their stability, convergence and robustness
properties and, most important, their convergence to the -unique - global minimum.  However, all these algorithms
deal with the case where the neural network has fixed regressor terms (nodes).  The problem of selecting the regressor
terms in neural networks is still an open and unsolved problem. In this paper, we propose algorithms for selecting the
regressor terms in linear-in-the-weight neural networks.  These algorithms are accompanied by appropriate learning
algorithms for adjusting the weights of the neural network.  By analyzing an appropriate error functional, we investi-
gate the convergence properties of the proposed algorithms; moreover, we investigate the optimality of these algo-
rithms and we construct conditions - regarding the nature of the regressor terms - under which the proposed algorithms
are optimal.



TA1 Intelligent Systems

TA1-7

A Simplex Trained Neural Network-Based Architecture for Sensor Fusion and Tracking of
Target Maneuvers

Yee Chin Wong, Malur K. Sundareshan

Abstract

One of the major applications for which neural network-based methods are being successfully employed is in the
design of intelligent integrated processing architectures that efficiently implement sensor fusion operations.  In this
paper we shall present  novel scheme for developing fused decisions for surveillance and tracking in typical multi-
sensor environments characterized by the disparity in the data streams arriving from various sensors.  This scheme
employs an integration of a multilayer neural network trained with features extracted from this multi-sensor data and
a Kalman filter in order to permit reliable tracking of maneuvering targets, and provides an intelligent way of imple-
menting an overall nonlinear tracking filter without any attendant increases in computational complexity.  A particular
focus is given to optimizing the neural network architecture and the learning strategy which are particularly critical to
develop the capabilities required for tracking of target maneuvers.  Towards these goals, a network growing scheme
and a simplex algorithm that seeks the global minimum of the training error are presented.  To provide validation of
these methods, results of several tracking experiments involving targets executing complex maneuvers in noisy and
clutter environments are presented.
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    TA2-1

The Finite Inclusions Theorem: A Tool for Robust Design

Theodore E. Djaferis

Abstract

Methods for robust controller design, are an invaluable tool in the hands of the control engineer.  Several methodologies have
been developed over the years and have been applied for the solution of specific robust design problems.  One of these meth-
ods, is based on the Finite Inclusions Theorem (FIT) and exploits properties of polynomials.  This has led to the development
of FIT-based algorithms for robust stabilization, robust asymptotic tracking and robust noise attenuation design.  In this paper,
we consider SISO systems with parameter uncertainty and show how FIT can be used to develop algorithms for robust phase
margin design.



 TA2 Robust Systems

TA2-2

Every Mode Robust Stabilization of Jump Linear Systems via LMIs

M. Ait Rami

Abstract

This paper considers the mode-dependent state-feedback control problem of linear systems subject to random Mark-
ovian jumps in parameter values.  For this kind of systems, the mean-square stability does not ensure the stability of
every mode in the deterministic sense.  We provide stabilizing solution in both senses.  The proposed approach differs
from the modified jump regulator approach and has several advantages.  The proposed conditions are only sufficient,
but less conservative.  We can treat uncertainties that can affect modes or the transition probability matrix.  The
problem is formulated as a convex constraint (LMIs) one.



TA2 Robust Systems

TA2-3

Robust Diagonal Stabilization and Finite Precision Problem: An LMI Approach

Stephane  Dussy

Abstract

Realization of digital filters or implementation of controllers in a digital computer may lead to unexpected instabilities
resulting from the finite precision effects.  Stability is usually ensured for an idealized discrete-time realization of the
system.  Nevertheless, as soon as A/D and D/A conversions get involved, the quantization of the state of the system,
due to adder overflow, magnitude truncation, finite wordlength format, may introduce severe nonlinearities respon-
sible for overflow oscillations, limit cycles or even chaotic behavior, even under zero input.  This paper considers a
parameter-dependent, discrete-time system in the companion form.  We derive LMI conditions ensuring stability for
the uncertain system in spite of the finite precision effect.  We also seek an LMI formulation for the synthesis of a
static output-feedback controller that guarantees robust stability for the finite precision problem.



TA2 Robust Systems

TA2-4

Robust Quasi NID Aircraft 3D Flight Control Under Sensor Noise

Marian J. Blachuta , Valery D. Yurkevich, Konrad Wojciechowski

Abstract

In the paper the design of an aircraft motion controller based on the Dynamic Contraction Method is presented.  The
control task is formulated as a tracking problem for Euler angles, where the desired decoupled output transients are
accomplished under assumption of high-level, high-frequency sensor noise and incomplete information about varying
parameters of the system and external disturbances.  The resulting controller has a simple form of a combination of a
low-order linear dynamical system and a matrix whose entries depend nonlinearly on certain measurable flight vari-
ables.



TA2 Robust Systems

TA2-5

Modeling and mu-Synthesis Robust Control of Two-Link Flexible Manipulators

Mansour Karkoub, Kumar Tamma

Abstract

Two-link robot manipulators are commonly used in industrial sectors such as manufacturing.  Some manipulators are
often bulky and their power consumption is relatively high.  Others, such as the arm on the space shuttle, are driven
slow to prevent the onset of flexible oscillations.  The efficiency of these manipulators  can be improved by reducing
the weight of some of these arms and/or increasing the speed of others.  These modifications complicate the dynamic
behavior of the system due to the possible onset of low frequency oscillations.  This paper addresses the issue of
modeling and end-point robust control of two-link flexible manipulators using the mu-synthesis technique.  The
Timoshenko beam theory along with the assumed modes method are used to derive reference equations of motion for
the flexible manipulator.  Discrepancies between the control design model and the actual dynamics of the manipulator
are attributed to neglect non-linearities such as cross-coupling which should be included in the controller design.  A
linear estimation of these errors will be identified and used in the control design to compensate for the unmodelled
dynamics of the flexible arm and parameter uncertainties.  The mu-synthesis control design techniques are then
employed to synthesize controllers for the two-link flexible robot manipulator.



TA2 Robust Systems

TA2-6

Exponentially-Weighted Iterative Solutions for Worst-Case Parameter Estimation

Ali H. Sayed, Andrea Garulli, V. Nascimento, S. Chandrasekaran

Abstract

This paper proposes an iterative scheme for worst-case parameter estimation in the presence of bounded model uncer-
tainties.  The algorithm distinguishes itself from other estimation schemes, such as errors-in-variables and other Hinf
methods, in that it leads to less conservative designs since it explicitly incorporates an a-priori bound on the size of the
uncertainties.  It also employs an exponential weighting scheme where data in the remote past are given less weight
than the most recent measurements.  This feature is especially useful in tracking problems where recent observations
carry more information about the current value of the unknown parameter.  Simulation results are included to demon-
strate the performance of the recursive scheme.
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Some Issues on Robust Control for Nonlinear Systems

Michael Athans, Alan Chao
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    TA3-1

Optimal Location of Actuators for an Active Noise Control Problem

Fariba Fahroo

Abstract

In this paper, we investigate the problem of finding the optimal location of controllers to achieve reduction of the
noise field in an acoustic cavity.  We first formulate a linear quadratic tracking problem in a Hilbert space, and then
consider the problem of optimization of an appropriate performance criterion with respect to the location of the
controls.  Numerical examples will be presented to illustrate our theoretical results.



 TA3 Modeling Estimation and Control of Infinite Dimensional Systems III

  TA3-2

Minimax Hinf Control of Stable Distributed Systems

Olof J. Staffans

Abstract

We study the distributed suboptimal full information Hinf problem for a stable well-posed linear system with
control u, disturbance w, state x and output y.  In our setting the transfer functions need not be rational or meromor-
phic; they are just plain Hinf without extra smoothness.  The problem is to find all suboptimal compensators, i.e.
compensators that make the norm of the closed loop input/output map from w to y less than a prescribed constant.
We use a game theory approach to this problem and regard it as a two player non-zero sum game.



TA3 Modeling Estimation and Control of Infinite Dimensional Systems III

    TA3-3

Conditional Moment Generating Functions for Integrals and Stochastic Integrals: Maximum-
Likelihood Estimation

Charalambos D. Charalambous

Abstract

In this paper we present two methods for computing filtered estimates for moments of integrals and stochastic inte-
grals of continuous-time nonlinear systems.  The first method utilizes recursive stochastic partial differential equa-
tions.  The second method utilizes conditional moment generating functions.  For the case of Gaussian systems the
recursive computations involve integrations with respect to Gaussian densities, while the moment generating func-
tions involve differentiations of parameter dependent ordinary stochastic differential equations.  The second method
is applied in the expectation optimization algorithm.
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    TA3-4

Ergodic Boundary Control of Semilinear Systems

T. E. Duncan
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A Robust-Adaptive Locomotion Controller For 9-Link Bipeds with Rapidly Varying Unknown
Parameters

S. G. Tzefestas, A. E. Krikochoritis, C. S. Tzefestas

Abstract

The control and the study of motion of a biped robot has always been a challenging problem.  The mechanical com-
plexity of biped robots, the existence of an unpowered degree of freedom and the peculiarity of their motion due to the
repeatability of movements and a permanent change of situations during one step, synthesize a complex problem.  At
the same time, undesired collisions with its environment, transport of unknown loads, or simplification of some
dynamic characteristics, cause uncertainty (structured or not) which makes worse the control problem since an accu-
rate model of the biped robot is not available.  In this paper a nine link planar biped model is studied.  It is a biped robot
that includes not only the main links: legs, thighs and trunk, but also a two segments foot.  For this biped robot, the
kinematics and dynamic equations which describe completely the locomotion of the robot during the different phases
of walking, are defined.  Furthermore, a continuous walking pattern on a flat terrain is designed and the corresponding
desired trajectories of the robot joints are calculated.  Then, a nonlinear robust control technique is adopted, based on
the fact that the control which has to ensure the stability of the biped robot must take into account the nonlinear
dynamics of the system.  This requires the knowledge of an accurate model of the biped robot, a condition that is never
fulfilled because of the existence of disturbances and modelling inaccuracies such as parametric uncertainty and
unmodeled dynamics.  Thus, for the case there is not available a priori information about the unknown parameters, the
parametric uncertainty has to be gradually reduced on-line by an adaptation or estimation mechanism.  Here, rapidly
time-varying unknown parameters are assumed, and a kind of robust-adaptive controller is designed which achieves
robustness, while at the same time ensures that all signals in the closed-loop robot system are bounded the tracking
error is of the order of parameter variations.  Extensive simulation experiments showed the effectiveness of the
proposed robust-adaptive control scheme.



 TA4 Mobile Robots

TA4-2

An Assessment of Fuzzy Logic for Collision Avoidance in a Multiple Autonomous Mobile Robot
System

Chris G. Dodds, Albert  Zomaya

Abstract

A fuzzy logic approach for collision avoidance in a multiple autonomous mobile robot environment is proposed.  Up
to four robots are given starting points and destinations they must reach within a hypothetical indoor environment.
The fuzzy logic method enables the robots to reach their intended destinations while avoiding stationary and mobile
obstacles alike.



TA4 Mobile Robots

 TA4-3

Steering a Robotic Snake

K. Sarrigeorgides, K. J. Kyriakopoulos

Abstract

In this paper we develop a methodology for steering on the plane the wheeled "snake" robot designed by Migadis and
Kyriakopoulos.  This mechanical system is subject to nonholonomic constraints.  The kinematic model of the mobile
robot is derived taking into consideration these constraints.  The nonholonomic motion planning is solved by convert-
ing the multiple input system to a multiple-chain, single generator chained form via state feedback and a coordinate
transformation. Simulation results are provided for a test case.
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 TA4-4

Motion Planning for Drift-Free Nonholonomic Systems Under a Discrete Levels Control Con-
straint

Photis G. Skiadas, Nick T. Koussoulas

Abstract

The motion planning problem for nonholonomic systems without drift is solved under the constraint that the control
inputs can take values in a set that contains a finite number of allowable levels.  If the system to be steered is also
nilpotent or nilpotentizable, the steering can be exact.  The results are applied in the steering of a simple system.



TA4 Mobile Robots

 TA4-5

Dynamic Modelling of a Tricycle Mobile Robot

Andre Kamga

Abstract

A control law is derived for path tracking of a tricycle mobile robot after its dynamics modelling.  The vehicle has a
front steering and driving wheel and two free rear wheels with a common rotation axis.  Thanks to poles placement, a
controller in the form of a linear feedback of the errors (position, orientation, lateral speed, and angular speed) for-
mally proves why such a system can be stabilized about a trajectory by using these above errors feedback to determine
the command to the steering angle.  Several simulation's results of the controller are presented.



TA4 Mobile Robots

TA4-6

A Navigation System With Self-Localization Capabilities for an Autonomous Mobile Robot

Alain Betourne, Alessandro Fefe, Salvatore Nicosia, Paolo Valigi

Abstract

In this paper a navigation system for an autonomous mobile robot is presented.  The system is based on the joint use
of an odometry, encoder based sensory system, of a vision system, and of an ultrasonic captor sensory system.  A
flexible hierarchical data structure is used to model complex, partially known, indoor environments, thus allowing the
navigation system to drive the robot in these environments, and to perform periodic corrections of the robot position,
by means of the vision system.  The proposed approach for image processing is based on the use of the Hough
transform.  The paper describes the overall navigation system, giving details on the environment modeling approach,
and on the image processing scheme.  Experimental tests have been performed, showing the good accuracy achieved
by the proposed position estimation scheme.



TA4 Mobile Robots
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Path following with security margin: A new control algorithm for wheeled Robots 

T. Hamel, P. Soueres, D. Meizel

Abstract

This paper addresses the problem of determining a feedback control law, robust with respect to localization errors,
allowing a mobile robot to follow a prescribed path.  The model we consider is a dynamic extension of the usual
kinematic model of a car, in the sense that we defined the path curvature as a new state variable.  The control variables
are respectively the linear velocity and the derivative of the curvature. By defining a sliding manifold we determine a
stabilizing controller for the nominal system i.e. when the exact configuration is supposed to be known.  Then, using
Lyapunov analysis, we prove that the system remains stable when the estimated values are used for feedback instead
of the exact ones, and we characterize the robustness with respect to localization and curvature estimation errors.  The
result is expressed by determining a bounded attractive domain where the vehicle's configuration could possibly lie
when the closed-loop control is performed with the estimated state values.  This domain allows to compute easily a
security margin for obstacle avoidance during the path-following phase.  Experimental results are presented at the end
of the paper.



TP1 Max-Algebra

    TP1-1

Linear Projectors in the Max-Plus Algebra

G. Cohen, S. Gaubert, J.-P. Quadrat

Abstract

For operators between finite-dimensional free moduloids, images are defined in the standard way whereas the notion
of kernel is replaced by the equivalence relation between elements with the same image.  Given a moduloid X, any x
in X, and two operators B ranging in X, and C with domain X, one raises the question of existence and uniqueness of
an element in the equivalence class of x modulo the kernel of C and which in addition belongs to the image of B.  Such
an element is then called the projection of x onto the image of B parallel to the kernel of C.  In a previous paper, this
question has been solved for residuated (possibly nonlinear) operators.  When a pair (B, C) satisfies the existence and
uniqueness conditions, the image of B and the kernel of C are in direct sum or are transverse.  In the present paper, we
revisit this problem in the case of linear operators.  We give a simpler characterization of transversality and an explicit
formula for the projector.  Unlike in vector spaces, for a given B, a transverse C need not exist, or, otherwise stated, the
image of B is not always that of a linear projector.  Indeed, the operators B for which this holds true are exactly those
for which a generalized inverse exists.  A computational algebraic test is given in order to check this property.



 TP1 Max-Algebra

TP1-2

Equivalence Classes of Rank-3 Matrices in the Max-Algebra

Jean-Michel Prou, Edouard Wagneur
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Control Synthesis Approaches Using the State Equations and the ARMA Model in Timed Event
Graphs

Philippe Declerck

Abstract

An important aim is to make control synthesis of processes modelled by timed event graphs.  Using the state equa-
tions, we solve the optimal tracking problem for any past evolution of the system.  However, the model is only a
picture of the reality and modelling errors and faults generate misestimation of the state vector.  In the case of an
unknown state vector, we propose to compensate this information loss by the use of "ARMA" model in control field.



TP1 Max-Algebra
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Dynamic Control of Kanban System Over Dioid Algebra

B. Cottenceau, L. Hardouin, J.-L. Boimond

Abstract

An objective of the just in time (JIT) manufacturing is to reduce work in process (WIP) inventory and to satisfy the
customers demand.  The most celebrated component is the so called Kanban method that we study in the dioid algebra
setting.  By considering the model of a Kanban cell we purpose dynamic controls of such systems.  The first proposed
control law allows to both decrease the WIP of a classical Kanban cell and to keep its output behavior.  The obtained
result is based on the residuation theory.  The analytical expression of this control law shows that the customers
demand will be known over a temporal horizon.  The second approach yields the greater control law in order to reduce
the WIP and to keep the same stock evolution in the output buffer of a classical Kanban cell.  It is shown that the
optimal control obtained does not need to have the future behavior of the customers demand.  Finally the proposed
control laws are extended to manufacturing systems with multiple Kanban cells.



TP1 Max-Algebra

TP1-5

Reachability and Observability of Linear Systems Over Max-Plus

M. J. Gazarik, E. W. Kamen

Abstract

This paper discusses the properties of reachability and observability for linear systems over the max-plus algebra.
Working in the event-domain, the concept of asticity is used to develop conditions for weak reachability and weak
observability.  In the reachability problem, residuation is used to determine if a state is reachable and to generate the
required control sequence to reach it.  In the observability problem, residuation is used to estimate the state.  As in the
continuous-variable case, a duality also exists between the properties.  Finally, an adjoint system is generated from the
residual calculation in the reachability case and utilized to generate a solution to the just-in-time (JIT) scheduling
problem.



TP1 Max-Algebra

 TP1-6

Controllability in the Max-Algebra

Jean-Michel Prou, Edouard Wagneur

Abstract

We are interested here in the reachability problem for DEDS in the max-algebra.  We show that this problem leads to
an eigenvector problem in the min algebra.  More precisely, we show that given a max-linear system, then, for every
natural number k > 1 there is a matrix Σk, whose eigenspace associated with the eigenvalue 1 (the multiplicative
identity, which coincides here with the real number 0 in the min algebra contains all the states which are reachable in
k steps.  Although not dealt with in this paper, a similar result also holds by duality on the observability side.



TP1 Max-Algebra

 TP1-7

Nonexpansive Maps and Option Pricing Theory

V. Kolokoltsov

Abstract

The famous Black-Sholes (BS) and Cox-Ross-Rubinstein (CRR) formulas are basic results in the modern theory of
option pricing in financial mathematics.  They are usually deduced by means of stochastic analysis; various generali-
zations of those formulas were proposed using more sophisticated stochastic models for common stocks pricing
evolution.  In this report, we argue that classical BS and CRR formulas can be actually obtained as a part of the theory
of nonexpansive maps, which contribute now one of the popular object of investigation in (max, +) algebra and its
applications to Discrete Event Systems.  This framework leads to another type of generalizations of BS and CRR
formulas characterized generally by more rough assumptions on common stocks. evolution, which are therefore easier
to verify.  On the other hand, this approach is more elementary: it leads to BS and CRR formulas without the use of
either martingales or stochastic equations.



                                   16

    TP2 Robust Systems II

    TP2-1

Robust Stability Analysis of GPC: An Application to Dead-Beat and Mean-Level Predictive
Controllers

Roberto Hernandez-Berlinches

Most stability results in model predictive control are based on the assumption that the model describes the real
plant perfectly.  In real systems the model is always different to the process and a robust stability analysis is
needed.  In this paper it is shown how the Extreme Point Results theory can be used to analyze the robust
stability of predictive controllers in a natural way with low computational cost.



 TP2 Robust Systems II

TP2-2

Robust Stability of Non-Linear Time-Varying Systems

Ezra Zeheb

Abstract

Systems with time-varying non-linearity confined to a given sector (Lure type) and a linear part with uncertainty
formulated by an interval transfer function, are considered.  Sufficient conditions satisfying the Popov criterion for
stability, which are computationally tractable, are derived.  The problem of checking the Popov criterion for an infi-
nite set of systems, is reduced to that of checking the Popov criterion for a finite number of fixed coefficient systems,
each in a prescribed frequency interval.



TP2 Robust Systems II

 TP2-3

Constrained Stabilization of a Dynamic System: A Case Study

F. Blanchini, S. Cotterli, G. Koruza , S. Miani, R. Siagri, L. Tubaro

Abstract

In this work we consider the problem of determining and implementing a state-feedback stabilizing controller law for
a laboratory two-tank dynamic system in the presence of state and control constraints.  We do this by exploiting the
properties of the polyhedral Lyapunov functions, i.e. Lyapunov functions whose level surfaces are polyhedra, in view
of their capability of providing an arbitrarily good approximation of the maximal set of attraction, which is the largest
set of initial states which can be brought to the origin with a guaranteed convergence speed.  We will first recall the
basic theoretical background needed for the scope and then we will report and analyze the results of the practical
implementation on a two-tank laboratory system of a linear variable-structure and a quantized control law proposed in
literature.  Finally an heuristic procedure for the determination of a static linear gain will be presented.



TP2 Robust Systems II

 TP2-4

Robust and Reliable Hinf Output Feedback Control for Linear Systems With Parameter Uncer-
tainty and Actuator Failure

Chang-Jun Seo, Byung Kook Kim

Abstract

The robust and reliable Hinf output feedback controller design problem is investigated for uncertain linear systems
with actuator failures within a prespecified subset of actuators.  The uncertainty considered here is time-varying
norm-bounded parameter uncertainty in the state matrix.  The output of a faulty actuator is assumed to be any arbitrary
energy-bounded signal.  An observer-based output feedback controller design is presented which stabilizes the plant
and guarantees an Hinf-norm bound on attenuation of augmented disturbances, for all admissible uncertainties as well
as actuator failures.  The construction of the observer-based output feedback control law requires the positive-definite
solutions of two algebraic Riccati equations.  The result can be regarded as an extension of existing results on robust
Hinf control and reliable Hinf control of uncertain linear systems.



TP2 Robust Systems II

  TP2-5

Quadratic Stabilizability of Uncertain Continuous-Time Systems Under State and Control
Constraints in the Presence of Disturbances

H. X. de Araujo, I. Queinnec, S. Tarbouriech

Abstract

The problem of finding a linear stabilizing state-feedback control for uncertain continuos-time linear systems with
state and control constraints is addressed.  Both convex-bounded parametric uncertainties and adaptive bounded
disturbances are considered.  Based on the theory of ellipsoidal positively invariant sets, a programming approach is
proposed to solve the control design problem.



TP2 Robust Systems II

TP2-6

Delay-dependent Robust Stability Tests and Decay Estimates for Systems With Input Delays

Kostas Hrissagis, Olga I. Kosmidou

Abstract

The robust asymptotic stabilization of uncertain systems with delays in the manipulated variables is considered in this
paper.  Sufficient conditions are derived that guarantee closed-loop stability under state-feedback control in the pres-
ence of nonlinear and/or time-varying perturbations.  The stability conditions are given in terms of scalar inequalities
and do not require the solution of Lyapunov  equations.  The approach makes use of the matrix measure to yield
robust-stability conditions.  The problem of constrained control is also discussed, and alternative stability conditions
for some case of saturation nonlinearities are presented.  Estimates of the stability degree and the rate of decay of the
solutions are also obtained.  Finally, an example illustrates the results.



TP3 Linear Systems I

    TP3-1

Transfer Function Equivalence of Feedback/Feedforward Compensators

Vladimir Kucera

Abstract

Equivalence of several feedback and/or feedforward compensation schemes in linear systems is investigated.  The
classes of compensators that are realizable using static or dynamic state feedback are characterized.  Stability of the
compensated system is studied.  Applications to model matching are included.



 TP3 Linear Systems I

TP3-2

Numerical Operations Among Rational Matrices: Standard Techniques and Interpolation

P. Husek, M. Sebek, J. Stecha

Abstract

Numerical operations on and among rational matrices are traditionally handled by direct manipulation with their
scalar entries.  A new and sometimes numerically attractive alternative is proposed here that is based on interpolation.
The procedure begins with evaluation of the rational matrices in several complex points.  Then all the required opera-
tions are performed consecutively on constant matrices corresponding to each particular point.  Finally, the resulting
rational matrix is recovered from the particular constant solutions via interpolation.  It may be computed either in
polynomial matrix of rational functions.  The operations considered include addition, multiplication and computation
of polynomial matrix fraction form.  The standard and the two interpolation methods are compared by experiments.



TP3 Linear Systems I

TP3-3

Design Fault-Tolerant of LTI State-Space Systems

C. N. Hadjicostis, G. C. Verghese

Abstract

The design of linear time-invariant (LTI) systems in state form has traditionally focused on implementations that
require the least number of state variables.  Such minimal designs have attempted to limit the requires resources, such
as hardware, computation time or power, by minimizing the system dimension.  In recent years, however, the increas-
ing necessity for the design and implementation of fault-tolerant systems has proved that "controlled redundancy"
(that is, redundancy that has been intentionally introduced in some systematic way) can be extremely important: it can
be used to detect and correct errors or to guarantee desirable performance despite hardware or computational failures.
Modular redundancy, the traditional approach to fault tolerance, is prohibitively expensive because of overhead in
replicating the hardware.  This paper discusses alternative methods for systematically introducing redundancy in LTI
systems in state form.  Our approach consists of mapping the state space of the original system into a redundant space
of higher dimension while preserving, within this larger space, the properties of the original system in some encoded
form.  We provide a complete characterization of the class of appropriate redundant LTI systems and illustrate through
several examples ways in which our framework can be used for achieving fault tolerance.



TP3 Linear Systems I

 TP3-4

An Integrated Framework for Input, Output and Control Structure Selection: Advanced Con-
trol Diagnostics

N. Karcanias, J. Leventides, E. Milonidis

Abstract

This paper aims at formulating an integrated approach to the overall problem of control structure selection and
identifying open issues and problems.  It is based on the assumption that there exists a progenitor model of the
linear type for the process, which however may not be well defined.  We then use structural analysis of the system
theoretic framework, the interaction measures and the results for the evaluation of alternative decentralization
schemes, to specify a step by step approach to the control structure selection.  The problem of handling alternative
criteria is also considered and basic elements of a system procedure are given.  There are many open issues, which
are identical and are still open and thus the proposed structural approach should be considered as the first step to the
development of an integrated methodology that involves the following major steps: (a)  Classification of system
model variables and definition of well structured progenitor model. (b)  Definition of effective input, output struc-
ture based on operability, controllability criteria.(c)  Determining the structure of the control scheme by evaluation
of alternative decentralized structures.  Finally the basics of methodology for sorting out the alternative criteria
which may be used in such problem are presented.



TP3 Linear Systems I

TP3-5

System Zeros Analysis via SVD of the First Nonzero Markov Parameter and the Kalman Decom-
position Theorem

Jerzy Tokarzewski

Abstract

In this paper we present a complete characterization of system zeros of an arbitrary linear system described by a state-
space model S(A, B, C, D).  The presented approach is based on singular value decomposition of the first nonzero
Markov parameter and the Kalman canonical decomposition theorem.  Invariant zeros are treated as the triples: com-
plex number, state-zero direction, input-zero direction.  Several numerical examples are discussed.



TP3 Linear Systems I

 TP3-6

Constrained Controllability of Dynamical Systems

Jerzy Klamka

Abstract

The present paper is devoted to a study of constrained controllability and controllability for linear dynamical systems
if controls are taken to be nonnegative.  In analogy to the usual definition of controllability it is possible to introduce
the concept of positive controllability.  We shall concentrate on approximate positive controllability for linear infi-
nite-dimensional dynamical systems when the values of controls are taken from a positive closed convex cone and the
operator of the system is normal and has pure discrete point spectrum.  The special attention is paid for positive
infinite-dimensional linear dynamical systems.  General approximate constrained controllability results are then ap-
plied for distributed parameter dynamical systems described by linear partial differential equations of parabolic type
different kinds of boundary conditions.  Several remarks and comments on the relationships between different con-
cepts of controllability are given.  Finally, simple numerical illustrative example is also presented.



TP4 Robot Control

    TP4-1

Global Asymptotic Stabilisation of an Active Mass Damper for a Flexible Beam

L. Menini, A. Tornambe, L. Zaccarian

 Abstract

In this paper, a finite dimensional approximated model of a mechanical system constituted by a vertical heavy flexible
beam with an active mobile mass located at the tip, is proposed; such a model is parametric in the approximation
order, so that a prescribed accuracy in the representation of the actual system can be easily obtained with the proposed
model.  The system itself can be understood as a simple representation of a building subject to transverse vibration,
whose vibrating modes are damped by a control action performed at the top by means of a moving mass.  A simple PD
control law, which requires only the measurement of the relative mass position and velocity with respect to the end-
point of the beam, is shown to globally asymptotically stabilize all the flexible modes considered in the approximation
model, regardless of the chosen approximation order.  Simulation runs confirm the effectiveness of the proposed
control law in achieving both position regulation of the mass and vibration control.



 TP4 Robot Control

 TP4-2

Variable Structure Control of a Robotic Assistance System

M. L. Corradini, T. Leo, G. Orlando

Abstract

The development of an autonomous robotic system for the assistance to disabled people (composed of a 'car-like'
mobile base and a robot arm) is the primary aim of the MOVAID Project, supported by the CEC in the framework of
the TIDE Programme.  In the context of the MOVAID Project, an automatic navigation system is currently being
developed at the Robotics Lab at the Dipartimento di Elettronica e Automatica.  From the functional viewpoint, the
navigation system can be decomposed into a motion planner and a collision avoidance module.  Both blocks, however
rely on a suitable low-level control procedure, which has to drive the wheel actuators in order to ensure the tracking of
the planned trajectory with a sufficient degree of precision, opposing eventual parameter variations and external
disturbances.  In this paper, a recently developed discrete-time Variable Structure Control (VSC) technique is applied
to the control of the steering-wheel robot of the MOVAID Project.  The algorithm has been designed in the discrete-
time domain, therefore allowing to avoid the well-known problems due to the discretization of continuous-time con-
trollers.  The simulation study reported in this note is preliminary to the experimental testing of the control algorithm,
which is being carried out.



TP4 Robot Control

 TP4-3

Control of Robot Manipulators Using CMAC Neural Networks

S. Commuri, S. Jagannathan, F. L. Lewis

Abstract

A comprehensive treatment of Cerebellar Model Articulation Controller (CMAC) Neural Network (NN) for the con-
trol of robot manipulators is presented.  The structure and localized learning properties of CMAC NN is exploited to
design efficient controllers for nonlinear systems belong to a given useful class.  Continuous and discrete-time imple-
mentation of these controllers are symmetrically examined.  Novel weight update schemes are derived and the closed-
loop stability of the controller and the system is rigorously proved.  These weight update schemes are shown to be
nonstandard modifications of adaptive techniques prevalent in the  literature.  Finally the validity of these techniques
are demonstrated through numerical studies.



TP4 Robot Control

TP4-4

On the Development of a Quick Connect Disconnect Coupler for Rapidly Configured Modular
Robots

P. S. Shiakolas, T. W. Sharpe, T. J. Lawley

Abstract

In this paper, we present a novel modular robot connection that provides for the rapid deployment of automation
through the quick and rapid configuration of robotic devices based on modules.  Modular robots have certain advan-
tages over conventional robots. A modular robot, can be defined as one for which the interchange of link and joint
modules quickly occurs with minimal basic adaptations to the base robotic hardware, eliminates many of the flexibil-
ity constraints of current robots and re-uses the modules for future configurations.  One important component of a
modular robot is a Quick Connect/Disconnect (QCD) joint coupler which provides for connection and separation as
well as orientation of the individual link-joint-actuator modules.  QCD based robots find applications in pilot and
prototyping environments, in manufacturing lines with low volume and multi-product production, and on mobile
platforms for unstructured manufacturing scenarios such as hazardous material handling and other manufacturing
environments.



TP4 Robot Control

TP4-5

Robot Control Using a Sliding Mode

M. Belhocine, M. Hamerlain, K. Bouyoucef

Abstract

The dynamical model of manipulator robot is represented by an equation system which are nonlinear and strongly
coupled.  Furthermore, the initial parameters of the manipulator depend on the payload which is often unknown and
variable.  So, to avoid these problems we studied variable structure system which is well suited for robotic arms.  To
this end, an application of the sliding mode control based on variable structure systems for a four degrees of freedom
robot is described in this paper.  This technique is applied to the regulation (point to point) control of SCARA robot.
So the aim of this work is to show the practical realization and to demonstrate the robustness and the validity of this
control law on the robot manipulator via experimental results obtained and discussed in the end.



WA1 Nonlinear Systems

    WA1-1

Set-Valued State Observers for Nonlinear Systems

Jeff S. Shamma, Kuang-Yang Tu

Abstract

A set-valued observer (SVO) produces a set of possible states based on output measurements and a priori  measure-
ments of exogenous disturbances and noises.  Previous work considered linear time-varying systems and unknown-
but-bounded exogenous signals.  In this case, the sets of possible state vectors take the form of polytopes whose
centers are optimal state estimates.  These polytopic sets can be computed by solving several small linear programs.  A
SVO can be constructed conceptually for nonlinear systems, however the set of possible state vectors no longer takes
the form of polytopes which in turn inhibits their explicit computation.  This paper considers an "extended SVO".  As
in the extended Kalman filter, the state equations are linearized about the state estimate, and a linear SVO is designed
along the linearization trajectory.  Under appropriate observability assumptions, it is shown that the extended SVO
provides an exponentially convergent state estimate in the case of sufficiently small initial condition uncertainty, and
provides a non-divergent state estimate in the case of sufficiently small exogenous signals.



 WA1 Nonlinear Systems

WA1-2

State Observers for Linear Systems With Smooth/Bounded Input

A. Germani, C. Manes

Abstract

It is known that for nonlinear systems the drift-observability property (i.e. observability for zero input) is not suffi-
cient to guarantee the existence of an asymptotic observer for any input.  Many authors studied conditions on systems
structure that ensure uniform observability (i.e. observability for any input).  Conditions are available that define
restrict classes of uniformly observable systems.  This work considers the problem of state observation with exponen-
tial error rate for smooth nonlinear systems that do not meet conditions of uniform observability: conditions are given
on the input, instead of on the system structure.  It is shown that drift-observability, together with a smoothness/
boundedness condition on the input, is sufficient to ensure the existence of an exponential observer.  Three types of
observers are presented, that can be constructed under drift-observability assumption.  One works well for systems
with maximal relative degree or in the case of input sufficiently small.  A second type of observer succeeds for
systems with any relative degree in the case of input sufficiently smooth.  The input derivatives up to a certain order
are required for its implementation.  Both observers ensure exponential convergence of exponential error to zero.  A
third observer suitable in the case of smooth input does not require input derivatives, and ensures exponential decay of
the observation error below a prescribed level.  Computer simulations close the paper.



WA1 Nonlinear Systems

WA1-3

Parameter Identification of Nonlinear Systems With Known Structure

A. Astolfi, J. J. Milek, F. J. Kraus

Abstract

This paper addresses the problem of on-line parameter estimation for non-linear continuous time dynamical systems
of known structure.  Two parameter estimation problems are formulated and explicitly solved.  The resulting param-
eter estimation algorithms incorporate an observer; the adjustment of the observer parameters is considered as a
stabilization problem for an uncertain system and is solved using sliding mode method.  In the full information
parameter estimation problem it is assumed that all the system states and their derivatives are known.  In the output
measurement parameter estimation problem we assume that only one state is known, the other states are reconstructed
using an adaptive observer.  The proposed algorithm is applied for parameter estimation of a Van der Pol oscillator.



WA1 Nonlinear Systems

WA1-4

Design and Analysis of Incipient Fault Diagnosis Schemes Using On-Line Approximators

Marios M. Polycarpou, Michael A. Demetriou

Abstract

Detection of incipient (slowly developing) faults is crucial in automated maintenance problems where early detection
of worn equipment is required.  In this note, a general framework for model-based fault detection and diagnosis of a
class of incipient faults is developed.  The changes in the system dynamics due the fault are modeled as nonlinear
functions of the state and input variables, while the time profile of the failure is assumed to be exponentially develop-
ing.  An automated fault diagnosis architecture using nonlinear on-line approximations with an adaptation scheme is
designed and analyzed.  A simulation example of a simple nonlinear mass-spring system is used to illustrate the
results.



WA1 Nonlinear Systems

 WA1-5

On Feedback Linearization Solution

M. Hou, A. C. Pugh

Abstract

Based upon a condensed Brunovsky form, feedback linearization for both single-input and multi-input nonlinear
systems is derived in a unified manner.  The derivation appears considerably simpler than the known derivations for
the multi-input case.  A straightforward characterization of the coordinate transformation required in the feedback
linearization is provided.



WA1 Nonlinear Systems

  WA1-6

On Singular Phenomena in Certain Time-Optimal Feedback System Operating by Discontinu-
ous Resistance

Wladyslaw Hejmo

Abstract

The purpose of this paper is to present the solution of selected time-optimal problems of the controlled object the dynamics of
which is given by: dx/dt = y, dy/dt = f(x) + u, where |u| < 1 and motion resistance function f(x) = 0 if x < 0, and f(x) = -A if x >
0 where 0 < A < 1.  That model describes dynamics of a very important class of industrial installations.



WA1 Nonlinear Systems

WA1-7

Emergency Control of Unstable Behavior of Nonlinear Systems Induced by Fault

Mark A. Pinsky, Michael V. Basin

Abstract

This paper presents the emergency control approach intended to urgently return to the stability basin the system states
affect by abrupt changes in certain system coefficient on a short time interval.  Because of its short duration, the
modeling of both the fault and controller involves delta- functions significantly simplifying analysis and control of
fault phenomena.  The design of an emergency controller is based on the technique for computing fault-induced jumps
of the system states, which is described in the paper.  A sample emergency controller instantaneously returning states
of a Van-der-Pol system to the stability basin is designed.



WA2 Applications

    WA2-1

A Symbolic Sensor for an Antilock Brake System of a Commercial Aircraft

B. Ewers, J. Bordeneuve-Guibe, Corrine Langlois

Abstract

The design of a symbolic sensor  that identifies the condition of the runway surface (dry, wet, icy, etc.) during the
braking of a commercial aircraft is discussed.  The purpose of such a sensor is to generate a qualitative, real-time
information about the runway surface to be integrated into the future aircraft Antilock Breaking System (ABS).  It can
be expected that this information can significantly improve the performance of ABS.  For the design of the symbolic
sensor different classification techniques based upon fuzzy set theory and neural networks are proposed.  To develop
and to verify these classification algorithms data recorded from recent breaking tests have been used.  The results
show that the symbolic sensor is able to correctly identify the surface condition.  Overall, the application example
considered in this paper demonstrates that symbolic information processing using fuzzy logic and neural networks has
the potential to provide new functions in control system design.  The paper is part of a common research project
between E.N.S.I.C.A. and Aerospatiale in France to study the role of the fuzzy set theory for potential applications in
future aircraft control systems.



WA2 Applications

 WA2-2

Multivariable Predictive Controller for a Test Stand of Air Conditioning

Cyril Vaucoret, Joel Bordeneuve-Guibe

Abstract

In this paper, a Multivariable Predictive Control (MPC) algorithm is developed and applied to an industrial test stand
for aircraft air conditioning systems.  This process has to satisfy a very strict specifications sheet over a large operating
range in order to simulate the working conditions of the aircraft equipment.  Multivariable identification tests have
been carried out to model the system and are reported here.  Finally, comparisons through simulation studies between
the existing PID regulation and the proposed MPC point out a great improvement of performance.



WA2 Applications

WA2-3

Hinf Control Design for an Adaptive Optics System

Nikolaos Denis, Douglas Looze, Jim Huang, David Castanon

Abstract

In this paper we first present a full order Hinf controller for a multi-input, multi-output (MIMO) adaptive optics
system.  We apply model reduction techniques to the full order Hinf controller and demonstrate that the closed loop
system with the reduced order Hinf controller achieves the same high level of performance.  Upon closer examination
of the structure of the reduced order Hinf controller it is found that the dynamical behavior of the reduced order Hinf
controller can be accurately approximated by a single-input, single-output (SISO) transfer function multiplied by the
inverse of the adaptive optics plant dc gain.  This observation then leads to a general design methodology which only
requires the synthesis of a SISO Hinf controller and multiplication by constant matrices.



WA2 Applications

 WA2-4

Optimal Fixture Design for Drilling in Elastically Deforming Plates

K. Wardak, U. Tasch, P. G. Charalambides



WA2 Applications

 WA2-5

Development of Mold Level Controller Using Sliding Mode Control in Continuous Casting
Processing

Seung Ryeol Yoo, Young Seub Kueon

Abstract

A sliding mode control was applied to mold level control in the continuous casting process.  The parameters of the
mathematical model are obtained by simulation with the data measured in POSCO's no.2 caster and adjusted though
on-line test.  The new controller based on VME bus system has parallel interface with a conventional controller.  The
sliding gate can be controlled by the controller selected between the developed and the conventional controller.  De-
veloped controller takes account of casting speed, tundish weight, mold width and etc. the deviation magnitude of the
mold level was reduced by the developed controller.



WA2 Applications

WA2-6

Modeling and Simulation of Blood Pump for Controller Development

Yih-Choung Yu, James F. Antaki, J. Robert Boston, Marwan Simaan, Phil J. Miller

Abstract

A mathematical model describing pressure-volume relationship of the Novacor left ventricular assist system (LVAS)
was developed.  The model consisted of lumped resistance, capacitance, and inductance elements with one time-
varying capacitor to simulate the cyclical pressure generation of the system.  The ejection and filling portions of the
pump cycle was modeled with two separate functions.  The corresponding model parameters were estimated by least
squares fit to experimental data obtained in the laboratory.  The model performed well at simulating pump pressure of
operation throughout the full cycle.  Computer simulation of the pump with a cardiovascular model demonstrated the
interaction between the LVAS with the cardiovascular system.  This model can be used to incorporate on-line cardio-
vascular parameter estimation and to design a new controller for the LVAS.



WA2 Applications

WA2-7

The Control and Structures Research Laboratory (CSRL): A Control-Oriented Test-Bed for
Large Segmented Reflectors

Majdedin Mirmirani, Helen R. Boussalis, Khosrow Rad, Mohluddin Ahmed, Anastasios Chassiakos,
Petros Ioannou, Elias Kosmatopoulos

Abstract

Because of the weight and volume constraints of space-borne instruments segmented reflectors have become only the
practical choice for future astrophysical missions.  While a monolithic reflector depends on the mechanical properties
of its material to provide the dimensional stability required for good optical performance, a segmented reflector
requires an active segment-alignment control system in order to make the reflecting surface have the optical perfor-
mance of a monolithic unit.  This paper describes an experimental test-bed that is being developed at the Control and
Structures Research Laboratory (CSRL) at California State University, Los Angeles (CSULA).  The CSRL test-bed is
a 2.4m focal length Cassegrain optical configuration consisting of a 2.66m actively controlled segmented primary and
an active secondary.  The primary consists of six hexagonal panels surrounding a fixed central panel and supported by
a light-weight flexible truss structure.  The project has been founded by NASA to study the complex dynamic behavior
of large segmented optical systems.



WA3 Linear Systems II

    WA3-1

I1-Optimal Control for Multirate Systems Under Full State Feedback

Johannes Aubrecht, Petros G. Voulgaris

Abstract

This paper considers the minimization of the Iinf-induced norm of the closed loop in linear multirate systems when
full state information is available for feedback.  A state-space approach is taken and concepts of viability theory and
controlled invariance are utilized.  The essential idea is to construct a set such that the state may be confined to that set
and that such a confinement guarantees that the output satisfies the desired output norm conditions.  Once such a set is
computed, it is shown that a memoryless nonlinear controller results, which achieves near-optimal performance.  The
construction involves the solution of several finite linear programs and generalizes to the multirate case earlier work
on linear time-invariant systems (LTI).



WA3 Linear Systems II

WA3-2

Ellipsoidal Bounding in Stable Predictive Control

M. Cannon, B. Kouvaritakis

Abstract

Efficient algorithms for approximate minimization of constrained infinite horizon predictive control costs are pre-
sented.  The resulting control laws have guaranteed stability and asymptotic tracking, and comparable performance
with existing QP-based control laws.



WA3 Linear Systems II

WA3-3

Constrained Stable Predictive Control: An I2-optimal Approach

B. Kouvaritakis, J. A. Rossiter, M. Cannon

Abstract

Perturbations on l2-optimal solutions are used for the derivation of efficient/feasible predictive algorithms.



WA3 Linear Systems II

WA3-4

The Performance of Generalized Minimum Variance System Identification

Odell R. Reynolds, Meir Pachter

Abstract

In this paper, a comparison is made between the novel Generalized Minimum Variance and established generalized
Least Squares estimation algorithms.  The emphasis of the Generalized Minimum Variance algorithm is on the proper
treatment of measurement noise for dynamical system identification.  The algorithms are compared in a carefully
performed, reproducible experiments which include measurement noise.  Differences are apparent under small mea-
surement samples, but the two appear to produce statistically similar results asymptotically.



WA3 Linear Systems II

 WA3-5

Weighted Hinf Mixed-Sensitivity Minimization for Stable Distributed Parameter Plants Under
Sampled-Data Control

Delano R. Carter, Armando A. Rodriguez

Abstract

This paper considers the problem of designing near-optimal finite-dimensional controllers for stable multiple-input
multiple-output (MIMO) distributed parameter plants under sampled-data control.  A weighted Hinf-style mixed-
sensitivity measure which penalizes the control is used to define the notion of optimality.  Controllers are generated by
solving a "natural" finite-dimensional sampled-data optimization.  A priori computable conditions are given on the
approximations such that the resulting finite-dimensional controllers stabilize the sampled-data controlled distributed
parameter plant and are near-optimal.  The proof relies on the fact that the control input is appropriately penalized in
the optimization.  This technique also assumes and exploits the fact that the plant can be approximated uniformly by
finite-dimensional systems.  Moreover, it is shown how the optimal performance may be estimated to any desired
degree of accuracy by solving a single finite-dimensional problem using a suitable finite-dimensional approximant.
The proofs and constructions given are simple.  Finally, it should be noted that no infinite-dimensional spectral
factorizations are required.  In short, the paper provides a straight forward control design approach for a large class of
MIMO distributed parameter systems under sampled-data control.



WA3 Linear Systems II

 WA3-6

On Sampled-Data Control Systems With Discontinuous Output

Marian J. Blachuta

Abstract

Discrete-time models of sampled-data control systems are addressed when both a continuous-time plant and a dis-
crete-time controller have feedthrough.  It is pointed out that in this case discrete-time models which can be found in
most references should not be used in the closed-loop context.  A new state-space model appropriate for the closed-
loop modeling, and formulae for calculating the related discrete-time pulse transfer functions are derived.  Intersample
phenomena are studied and the feasibility of that model to describe systems with parasitic dynamics is emphasized.
Examples from the literature illustrate the relevance of the issue.



WA4 Automotive Systems

    WA4-1

Macroscopic Traffic Flow Modeling of Automated Highway Systems

H. Raza, P. Ioannou

Abstract

An accurate macroscopic traffic flow model of automated highways is necessary not only for analyzing the collective
dynamical behavior of automated vehicles but also for designing control laws to improve system level performance.
In this paper a macroscopic model for describing the traffic flow on automated highways is developed by using the
microscopic control laws that govern the motion of individual vehicles.  Some assumptions were used to derive the
instantaneous speed and density profiles from the kinematics of individual vehicles.  We have given enough structure
to the modeling task, so that the model is independent of the implementation details, hence can be applied to a wide
variety of automated highway concepts.  The developed model can be used to analyze the steady state behavior of
AHS traffic flow for different operating conditions and is currently under study.  We plan to use the results of this
analysis as guidelines for designing macroscopic as well as microscopic control laws.



 WA4 Automotive Systems

 WA4-2

Robust Prevention of Limit Cycles for Robustly Decoupled Car Steering Dynamics

Juergen Ackermann, Tilman Buente

Abstract

Considerable safety benefits are achieved by robustly decoupling the lateral and yaw motions of a car with active
steering.  Robust unilateral decoupling requires an actuator to generate an additional front wheel steering angle.
However, introducing actuators to closed loop systems may cause undesired limit cycles due to actuator saturation and
rate limits.  By introducing a simple nonlinear modification of the control law, this paper proposes a remedy to prevent
limit cycles for robustly decoupled car steering dynamics.  The robustness of the resulting system w.r.t. the avoidance
of limit cycles is investigated for varying operating conditions by combining the parameter space approach and the
theory of describing functions.



WA4 Automotive Systems

 WA4-3

Modular Design for the Computation of Vehicle Dynamic Behavior

R. Majjad, U. Kiencke

Abstract

In the last years many efforts have been done to develop simulation models.  These models need a lot of computational
time.  This paper presents a new modular simulation to avoid these problems.  This approach requires a good tire
model to take the nonlinearities into account which have a significant influence on the dynamic behavior of the car.
The process of composing the model is modular and consists of several sub-models (tires, chassis, suspension, steer-
ing, wind, road).  Each of them can be developed independently.  The advantage of the simulation is the reduction of
time and costs for designing and engineering different controller concepts or vehicle safety systems.  It will be proved
with different examples that this simulation gives good results for the realistic behavior of the vehicle.  The time of
simulation is reduced by minimizing the coordinate transformations.
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 WA4-4

Identification of Parameters for Complex Vehicle Models

R. Majjad, M. Hafner

Abstract

In the last years many efforts have been done to develop simulation models.  These models need a large amount of
parameters. Many of these parameters are unknown and difficult to measure.  A precise knowledge of interior param-
eters of the car is necessary to be able to make a model which delivers accurate and reliable results.  This paper
presents the identification of some important parameters concerning the dynamical behavior of the vehicle.  These
parameters are the load slope ε and the moments of inertia JX, JY, JZ for the x-, y- and z-axis and the mass of the chassis.
To achieve this goal, a non-linear observer will be used to calculate and to validate the wheel forces which are needed
as input values for an estimator.  The five parameters are estimated using a RLS method.  According to measurements
in a test car our method delivers a very good estimation for the behavior of the vehicle.



WA4 Automotive Systems

WA4-5

Fuzzy Parking and Point Stabilization:Application Car Dynamics Model

S. Bentalba, A. El Hajjaji, A. Rachid

Abstract

The first specific problem in this paper is to park a car to a given goal x-position at right angle starting from a given
configuration by controlling the acceleration or deceleration force and steering angle of wheels.  After dealing with
the parking problem, two fuzzy controllers are proposed, the first generates the steering angle from position and
orientation errors of the car, while the second controller generates the acceleration or deceleration force from the
generated steering angle and the speed of the car.  From these controllers and with a geometric transformation, we
design a new control method for the second purpose in this study which consists to stabilize the car to a given goal
coordinates and an orientation starting from a given position.  Simulation results using dynamics car are successfully
performed.
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 WA4-6

Sliding Mode Control of a Turbocharged Diesel Engine

S. Ouenou-Gamo, A. Benchaib, A. Rachid, M. Ouladsine

Abstract

This study seeks to apply sliding mode control on a turbocharger Diesel engine.  A complete physical model followed
by a reduced form and taking into account thermodynamics of the different steps of the Diesel cycle has never been
proposed in the literature.  The study shows the role of the turbocompressor on the cylinder filling during the air intake
and the exhaust phases on different engine states through thermodynamically laws.  This is an attempt to describe the
dynamics of the diesel engine by physical equations.  The sliding mode control method is used and a solution to the
multivariable system control problem is presented.  A compressor power control approach is used and relationships
between fluid states in the air intake and the exhaust manifold pressure are discussed.



WP1 Two-Dimensional Systems

    WP1-1

A New Method for Computing the Stability Margin of Two-Dimensional Systems

Nikos E. Mastorakis

Abstract

The stability margin of 2-D (two-dimensional) Linear Shift Invariant causal single-input single-output discrete sys-
tems is investigated.  A new method to compute the stability margin of 2-D continuous systems is considered.  Illus-
trative examples are also included.



WP1 Two-Dimensional Systems

 WP1-2

New Stability Test for 2-D Systems

Nikos E. Mastorakis

Abstract

In this paper, a new stability test for two-dimensional (2-D) discrete systems is presented.  The proposed test is based
on a simple 1-D test which is simpler but equivalent to that of Schur-Cohn.  The test can be easily automated via a
suitable computer code.  Examples are given.
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 WP1-3

Reachability and Minimum Energy Control of Nonnegative
2D Roesser Type Models

Tadeusz Kaczorek

Abstract

A new class of nonnegative 2D Roesser type models is introduced.  Necessary and sufficient conditions are estab-
lished for the reachability of the nonnegative 2D Roesser type model for zero boundary conditions.  It is shown that the
nonnegative 2D Roesser type model having no nilpotent system matrix is unreachable for nonzero boundary condi-
tions.  The minimum energy control problem is formulated and solved for the nonnegative 2D Roesser type model
with zero boundary conditions.  The considerations are illustrated by means of a numerical example.



WP1 Two-Dimensional Systems

 WP1-4

Some Results on the Dynamics of 2D Positive Systems

Ettore Fornasini, Maria Elena Valcher



WP2 Adaptive Control

    WP2-1

Adaptive Control of Discrete-Time Output-Feedback Nonlinear Systems

Jiaxiang Zhao, Ioannis Kanellakopoulos

Abstract

In adaptive control design for discrete-time output-feedback nonlinear plants, the main obstacle is the lack of effective
ways to design estimators for the unmeasured states and the unknown parameters.  Since these quantities appear as
arguments of arbitrary nonlinear functions, traditional estimation methods cannot be used.  To resolve this problem,
we propose a new systematic methodology by which one can recover all the necessary information about the unknown
part of the system in finite time, so that a control schemes for global stabilization and tracking can be designed for
such plants.



 WP2 Adaptive Control

 WP2-2

An Uncertainty Model Validation Approach to Adaptive Robust Linear Control

Robert E. Kosut

Abstract

It is shown that validation (unfalsification) of the standard robust control design uncertainty model is the natural
replacement for system identification when the intended use of the model is robust control.  The result is an "uncer-
tainty" tradeoff curve between model uncertainty and disturbance uncertainty.  Hence, a family of uncertainty models
are unfalsified (validated) from the data record.  The family of unfalsified models can be used in an iterative approach
to system identification and robust control design.  The idea can be applied iteratively to both the plant model and the
resulting candidate robust control.
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 WP2-3

Application of a Multivariable Adaptive Controller with PID Structure to a Wastewater Treat-
ment Plant with D-N Configuration

A. M. Macarulla, J. Florez, J. X. Ostolaza, E. Ayesa

Abstract

In this paper a multivariable adaptive controller with PID structure based on the algorithm developed by Yusof and
Omatu (1993) using the Minimum Variance strategy, has been applied to a model of a municipal Wastewater Treat-
ment Plant (WWTP) with nitrification and dinitrification processes (D-N configuration).  This plant is a non-linear
process with low controllability.  The aim of the controller is to improve the overall performance of the system.  The
process must satisfy the quality requirements of the effluent water in terms of its concentrations of nitrates and ammo-
nia.  The manipulable variables are the Dissolved Oxygen level in the oxic reactor and the Internal Recycle flow rate.
The results presented show the response of the plant and the controller under a seasonal variation of temperature.
They prove that the operation of the plant is improved, and running costs are lower.
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 WP2-4

Adaptive Variable Structure Control of Robot Manipulators With Exponentially Stable Trajec-
tories

H. Yu

Abstract

An adaptive variable structure control approach for the robot manipulators is proposed in this paper.  The proposed
approach avoids requirement of the uncertain parameter bounds  which is adopted in the most robust control methods,
and makes the tracking error converge to zero exponentially without requiring any persistent excitation.  In addition,
the fast parameter variations (e.g. payload variation) are allowed, unlike the conventional adaptive control method
which assumed that the parameter variations are slower than the adaptive mechanism.



WP3 Linear Systems III

    WP3-1

Normalized Coprime Factorizations for Discrete-Time Periodic Systems

Baohui Xie, Vassilis l. Syrmos

Abstract

In this paper the notation of Normalized Coprime Factorization (NCF) for linear discrete-time periodic systems is
studied.  These systems arise in the study of linear time-varying systems with periodic coefficients.  The problem is
approached by the study of the original linear periodic state space representation of the system instead of its linear
time-invariant representation using lifting technique.  It is shown that the NCF can be obtained through the solution to
Discrete Periodic Riccati Equations (DPRE).  The properties of the DPRE are used to study the NCF for the linear
periodic systems.



 WP3 Linear Systems III

 WP3-2

The Tracking and Regulation Problem for a Class of Generalized Systems

Antonio Tornambe

Abstract

The tracking and regulation problem is considered for a class of generalized systems, in case of exponential reference
signals and of disturbance functions.  First, the notions of steady-state response and of blocking zero, which are
classical for linear time-invariant systems, are given for generalized systems.  Then, the tracking and regulation
problem is stated and solved for the class of generalized systems under consideration, giving a general design proce-
dure.  As a corollary of the effectiveness proof of the design procedure, an algebraic version of the internal model
principle is stated for generalized systems.
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 WP3-3

Dynamic Output Feedback Stabilization for a Class of Saturated Linear Systems

M. Klai, Y. Ait-Amirat

Abstract

This paper addresses the problem of the global stabilization of a linear system with saturating controls by means of a
dynamic output feedback using a saturated linear controller built from an observer.  It is shown that a simple linear
control law of an optimal-like type always globally stabilizes the closed-loop system when the linear system to be
controlled is asymptotically or critically stable.



WP3 Linear Systems III

 WP3-4

Stabilization Independent of Delay for Saturated Linear Systems

M. Klai, Y. Ait-Amirat

Abstract

This paper deals with the problem of global stabilization independent of delay for a class of delayed linear systems
subject to bounded controls.  A new sufficient condition addressing the global asymptotic stabilization (G.A.S.), via
saturated (static or dynamic) feedback, of such class of systems is proposed.  It concerns the class of systems for which
the open-loop system without time-delay term is Hurwitz.



WP3 Linear Systems III

 WP3-5

Design of L.Q.G. Dissipative Controllers Using Linear Matrix Inequalities

R. Drai

Abstract

We present an application of the Linear Matrix Inequality approach to robust control to the design of multivariable
L.Q.G. controllers verifying various sector conditions that generalize existing results concerning positive real sys-
tems.  The main result is illustrated by considering robust attitude control of a telecommunication satellite in an
acceleration maneuver.



WP4 Digital Signal Processing II

    WP4-1

An Application of the EM Algorithm to Sequence Estimation in the Presence of Tone Interfer-
ence

Quan G. Zhang, Costas N. Georghiades

Abstract

For a direct-sequence spread-spectrum (DS-SS) system we pose and solve the problem of maximum-likelihood (ML)
sequence estimation in the presence of narrowband interference, using the expectation-maximization (EM) algorithm.
It is seen that the iterative EM algorithm obtains at each iteration an estimate of the interference which is then sub-
tracted from the data before a new sequence estimate is produced.  Both uncoded and trellis coded systems are studied,
and the EM-based algorithm is seen to perform well, outperforming a receiver that uses an optimized notch filter to
remove the interference, especially for large interference levels.



 WP4 Digital Signal Processing II

 WP4-2

A Nonlinear Filtering Algorithm for the Measurement of Rainfall Drop Size Distribution

Takis Kasparis, John Lane

Abstract

Using an impulse suppression algorithm, environmental noise such as thunder and wind can be filtered from the sound
of raindrops impacting an acoustic rain gauge sensor.  A non-linear filter algorithm, based on a gated median filter,
was previously used to suppress scratch noise from damaged phonograph records.  The goal of this work is to adapt
this impulse suppression algorithm and evaluate its performance in detecting and filtering the impulse signal from a
sensor element of the Acoustic Rain Gauge Array at the University of Central Florida.  In this case, the amplitude of
each impulse is a measurement of the raindrop size impacting sensor.  By subtracting the filtered signal from a delayed
version of the original, the output signal contains only the drop impulses from which the raindrop size impacting the



 WP4 Digital Signal Processing II

 WP4-3

Invariant Line Matching Theory of Consecutive Images

Djemma Kachi, Xiao-Wei Tu

Abstract

This  paper presents a general line matching method based on geometrical invariants.   A line segment is characterized
locally by invariant parameters under the group of displacements within an image and the scale changes.  Matching
is achieved through two steps, features clustering and hypothesis verification.  In order to be matched, a pair of lines
represented by neighboring features must satisfy geometrical  constraints ( relative angle and distance ) in the image
plane.  Experiments have shown an high rate matching  of different types of images. this is due to the stability of the 
used line invariants which lead to few hypotheses of matching, as well as the verification using geometrical constraints.
Tests conducted on different images sequences have shown efficient matching of images and parts of scenes.
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Browsing with bookmarks

Bookmarks can mark parts of a document for quick 
access, link to page views in other documents, link 
to the Web, play a movie or sound, enter an article, 
and reset or submit a form. 

To jump to a topic by using its bookmark:

1 Click the Bookmarks and Page button b or choose 
View > Bookmarks and Page to display bookmarks in 
the overview area. If a triangle appears to the left of 
the bookmark, click the triangle to show or hide 
subordinate bookmarks.

2 To go to the destination specified by a bookmark, 
click the bookmark text or double-click the page icon 
to the left of the bookmark name. A bookmark can also 
change the page view, play a movie, reset a form, or 
perform other actions.
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How to use this online guide

 

Use these procedures to navigate through this guide:

Click underlined text to go to the topic indicated. Underlined 
text indicates text that is “linked” to another part of this 
guide. For example, see Browsing through documents for 
more information on how to page through Acrobat 
documents.

Click the Go Back button in the toolbar to return to your 
previous location.

Click the Next Page button in the toolbar to go to the next 
page of the guide. 

Click the First Page button in the toolbar to return to the 
opening screen of this guide. 

Click the bookmark name to go to the topic marked by that 
bookmark. Click the triangle to the left of a bookmark to 
show and hide subordinate bookmarks. The bookmarks for 
this guide provide a complete list of topics.

Click the arrow button to go to the next screen of any 
continued topic.

TopicTopic
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How long 
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Opening an Acrobat document 

 

Choose Open from the File menu to open an existing Acrobat 
document. In the Open File dialog box, highlight the filename, 
and click Open. Acrobat documents have the extension .pdf (for 
example, pdfmark.pdf). You can also open an Acrobat document 
by double-clicking its icon from the Finder (Macintosh) or from 
the File Manager (Windows).

When you start Acrobat Exchange or Reader, the Open File dialog 
box appears for you to select a file.
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Tools and buttons

 

The toolbar contains tools for selecting, viewing, annotating, and 
linking documents. Select a tool by clicking the tool icon. 

To hide or show the toolbar, choose Hide Toolbar or Show Toolbar 
from the Window menu. The command alternates between the two 
options.

The toolbar contains the following tools and buttons:

The 

 

Page Only

 

 button closes the overview area of the window. 

The 

 

Bookmarks and Page

 

 button opens the overview area 
and displays bookmarks created for the document. Click a book-
mark’s name to go to the location marked by that bookmark. See 
Using bookmarks for more information.

The 

 

Thumbnails and Page

 

 button opens the overview area and 
displays thumbnail images of each document page. Click a 
thumbnail to go to the page marked by that thumbnail. See Using 
thumbnails for more information.
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The 

 

hand

 

 tool enables you to move a single document page on 
the screen when the page does not fit within the main window. 
Drag the hand tool in the direction you want to move the page. 

The 

 

zoom

 

 tools magnify and reduce the page display. 
See Magnifying the page view for more information.

The 

 

select text

 

 tool enables you to select text in a document. 
This text can then be copied to the Clipboard by using the Copy 
command. See Copying text to the Clipboard for more 
information.

The 

 

select graphics

 

 tool (located in the Tools menu) selects 
graphics in a document. These graphics can then be copied 
to the Clipboard by using the Copy command. See Copying 
graphics to the Clipboard for more information.

The 

 

note

 

 tool lets you add notes to a document. (If the note tool 
does not appear in the toolbar, choose Full Menus from the Edit 
menu.) See Using notes for more information.
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The 

 

link

 

 tool enables you to create or modify a link between two 
parts of any PDF document or between two PDF documents. (If 
the link tool does not appear in the toolbar, choose Full Menus 
from the Edit menu.) See Using links for more information.

The 

 

article

 

 tool (located in the Tools menu) enables you to 
define automatic text flows, or articles, to guide readers through 
documents. See Creating articles for more information.

The 

 

Previous Page

 

 and 

 

Next Page 

 

buttons move the 
document backward or forward one page at a time. See 
Browsing through documents for more information.

The 

 

First Page

 

 and 

 

Last page 

 

buttons move the 
document to the first or last page of a document. See 
Browsing through documents for more information.

The 

 

Go Back

 

 and 

 

Go Forward

 

 buttons retrace your steps 
through a document, moving to each view in the order 
visited. Go Back also returns you to the original document 
when you click a link to another document. See Browsing 
through documents for more information.
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 The 

 

Actual Size

 

 button displays the page at 100 %
magnification.

 The 

 

Fit Page

 

 button scales the page to fit within the window.

 The 

 

Fit Width

 

 button scales the page to fill the width of the 
window. Holding down Control (Windows) or Option (Macintosh) 
and clicking the Fit Width button scales the page so that the 
visible text and graphics fit the width of the window.

The 

 

Find

 

 button searches for part of a word, a complete word, 
or multiple words in a document. See Finding words for more 
information.

The 

 

Search

 

 button searches indexed PDF documents for single 
words, phrases, or combinations of words. See Searching 
indexed document collections

 

 

 

for more information. 

The 

 

Search Results

 

 button displays the results of your 
cross-document search. 
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The 

 

Search Next

 

 button displays the next occurrence of a 
search term found by the search tool.

The 

 

Search Previous

 

 button displays the previous occurrence 
of a search term found by the search tool.

The 

 

Web Browser

 

 button starts your Web browser. If your Web 
browser is already running, it becomes the active application. 
(If the Web Browser button does not appear in the toolbar, make 
sure you have the Weblink plug-in installed.) See Using Web links 
for more information.

The 

 

Movie 

 

tool enables you to add digital movies and sounds to 
your PDF document. (If the movie tool does not appear in the 
toolbar, make sure you have the Movie plug-in installed.) See 
Using the movie tool for more information.
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Status bar fields and controls

 

The status bar contains the following fields and controls:

The 

 

window splitter 

 

lets you adjust the width of the over-
view and document areas. Drag the control to where you 
want to divide the two areas.

The 

 

page number box

 

 displays the current page number 
and lets you go to a specified page in a multipage docu-
ment. To move to a page, click the page number box to 
display the Go To Page dialog box, enter the page number, 
and click OK.

The 

 

magnification box

 

 displays the current page magni-
fication and lets you select various magnifications and 
page views. To select a custom magnification, choose 
Other from the menu and enter the value in the Zoom To 
dialog box. See Magnifying the page view for more 
information.

The

 

 page size box

 

 shows the size of the current page by 
using the units specified in the Preferences dialog box.
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Displaying information about a document
The Document Info submenu in the File menu contains commands 
that display general, font, open, and security information about a 
document. As a document reader, you may want to refer to this 
information. When you create a document, you can set attributes 
that determine how the document is displayed when it opens.

The General Info dialog box consists of four document attributes 
that the document creator can enter or modify in text boxes: Title, 
Subject, Author, and Keywords. This data, which is analogous to a 
card catalog entry, can be used for searches of libraries of PDF 
documents indexed by using Acrobat Catalog. Document readers can 
use the Search command in Acrobat Exchange to search indexed PDF 
documents quickly for single words, phrases, parts of words, or 
combinations of words. For information on how to use the Search 
command, see Searching indexed document collections. 

Note: The title is the document’s title, not the filename (unless the 
title and filename are identical).
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In addition to the modifiable document data, the Document Info 
dialog box displays document attributes set by Acrobat PDF Writer 
or Acrobat Distiller:

• Creator indicates the program that created the document (if 
known).

• Producer indicates the application or driver that produced the 
PDF document.

• Created indicates date and time the document was created.

• Modified indicates date and time the document was modified.

The Font Information dialog box describes the font attributes 
for the current document. To see a list of all fonts used in the 
document, click the List All Fonts button. 

The Open Information dialog box enables you to specify how the 
document is displayed when it opens. The document can be set to 
open full screen and at a page other than the first. You can also have 
the document open with or without bookmarks or thumbnails, and 
you can set the magnification level for the entire document. 
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Enter the page on which the document should open in the Go To 
Page text box. If you want to change the document’s original magni-
fication level from the default—the application’s default magnifica-
tion setting when opening the document—select another value from 
the menu. The values are the same as those in the magnification 
box. Any other value you select overrides the default and will cause 
the document to open with another magnification, such as Fit Page. 

The Security Information dialog box, which is not editable, indicates 
the document’s security status. See Setting document security for 
more information.
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Displaying documents in full-screen mode
Document readers can select Full Screen from the View menu so 
that the PDF document fills the entire monitor screen (similar to 
a television image).

Document creators can set PDF documents to open in full-screen 
mode by choosing Document Info/Open from the File menu and 
then clicking the Full Screen option in the Open Info dialog box. 
The Full Screen setting can be used for documents that are to be 
displayed as slide shows with automatic page turning, or for 
documents that page continuously on kiosks. 

The characteristics of full-screen documents—page advancement 
and background color—are set through the Full Screen Preferences 
dialog box. See Full-screen preferences for more information.

A limited set of keyboard accelerators is active in full-screen mode—
primarily those related to page navigation and view magnification. 
The pointer remains active during full-screen mode so that users can 
click links and open notes.
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Thumbnails or bookmarks are not accessible in full-screen mode. 
If a link forces the opening of a PDF file whose Open attribute is to 
display bookmarks or thumbnails, only the page will be displayed. 
The document’s Open attributes for page and view magnification, 
however, will be maintained.

The tools and commands in the following menus are accessible 
through their keyboard shortcuts:

• The View menu includes all commands except Page Only, Book-
marks and Page, and Thumbnails and Page.

• The Tools menu includes the hand, zoom-in, and zoom-out tools.

To exit from full-screen display mode, press the Escape key or 
advance past the last page.
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Magnifying the page view
You can use the zoom tools or the magnification box in the status 
bar to change the screen magnification. 

To use the zoom tools:

• Click the zoom-in tool e to double the magnification. 

Click the zoom-out tool f to halve the magnification.

• To magnify or reduce a selected area, select a zoom tool and drag 
the mouse to draw a rectangle around the area you want to view. 
With the zoom-in tool, the page view expands to show just the 
contents of the rectangle. With the zoom-out tool, the current page 
view reduces to fit within the rectangle.

• To toggle between the zoom-in and zoom-out tools, press Control 
(Windows) or Option (Macintosh).
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To use the magnification box:

Move the pointer over the magnification box in the status bar, and 
press the mouse button. Select a magnification level from the list, or 
select one of the following:

• Fit Page scales the page to fit within the main window. 

• Fit Width scales the page to fit the width of the main window.

• Fit Visible fills the window with the page’s imaged area only (text 
and graphics).

• Other sets the magnification to the value entered in the Zoom To 
dialog box.

When you select any of the Fit options, the current magnification 
level is displayed in the status bar.

The zoom options, Fit Page, Fit Width, and Fit Visible are in a sticky 
state, which means they don’t change as you page through a docu-
ment, unless you change the zoom. A sticky zoom state is indicated 
by a check mark next to the item in the View menu, and the item is 
selected in the toolbar.
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To cancel a sticky zoom state:

Choose one of the following options:

• Click the Fit Page or Fit Visible button in the toolbar. 

• Select an explicit zoom magnification level, including Actual 
Size (100%).

• Select a thumbnail zoom. 

• Go to a link whose destination includes a specific magnification. 
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Browsing through documents
The Acrobat Exchange program provides a number of ways to 
browse through a document.

To page through a document:

Click the Previous Page l or Next Page button m to move back or 
forward one page. You can also use the Previous Page and Next Page 
commands in the View menu or the Left Arrow (or Up Arrow) and 
Right Arrow (or Down Arrow) keys on your keyboard. Use the 
PageUp or PageDown key on the keyboard to move forward or back 
one screenful at a time. (If your keyboard doesn’t have PageUp and 
PageDown keys, press Return for PageDown and Shift+Return for 
PageUp.)

Use the vertical scroll bar to scroll forward and back through a doc-
ument. As you drag the scroll box, a box to the left of the scroll bar 
displays the current page number. Click above or beneath the scroll 
box to move back or forward one screenful.

Use the horizontal scroll bar in the status bar to scroll the page right 
or left.
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To jump to a specified page:

Click the First Page k or Last Page button n to move to the first or 
last page of a document. You can also use the First Page and Last 
Page commands in the View menu or the Home and End keys on the 
keyboard. 

Click the page number box in the status bar at the bottom of the 
main window, or choose Go To Page from the View menu to open 
the Go To Page dialog box; then enter the page number you want, 
and click OK.

You can also use thumbnails and bookmarks in the overview area to 
jump to specified pages. See Using thumbnails and Using bookmarks 
for more information.

To retrace your steps in a document:

Click the Go Back o and Go Forward p buttons to retrace your 
steps through a document, one view at a time. You can also use the 
Go Back and Go Forward commands in the View menu.
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Note that Go Back returns you to your previous page view. Your pre-
vious page view might be the previous page or screen, or it might be 
a reduced or magnified view. Your previous page view might also be 
the page view before you scrolled by using the scroll bars or hand 
tool.

Go Back is useful for recovering from navigational mistakes. If you 
zoom in or out by mistake, or if you jump to the wrong page, click 
Go Back to undo your action. You can use the Go Back feature to 
retrace up to 60 previous views.

Go Forward reverses direction and returns you, one view at a time, to 
the view where you first used Go Back.

To return to a previous document:

After you click a link or bookmark that takes you to another docu-
ment, click Go Back 

o
 or choose Go Back from the View menu to 

return to the previous document.
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Using thumbnails
Thumbnails are miniature page views that can be displayed in the 
overview area. You can use thumbnails to jump quickly to a page; to 
adjust the view of the current page; and to move, insert, and delete 
pages. 

To browse by using thumbnails:

Click the Thumbnails and Page button c or choose View > 
Thumbnails and Page to display thumbnail images of each 
page in the document in the overview area. Click a thumbnail 
to move to that page. The location you click determines the 
center of the page display.

To adjust the page view:

• Use the hand tool d to drag the page-view box (the light-gray 
box) on the thumbnail to move around the current page.

• Drag the lower right corner of the page-view box to reduce or 
expand the view of the current page. 

• Position the pointer anywhere outside the current page-view box 
and drag to draw a new box. 
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Editing pages by using thumbnails
You can use thumbnails to move, copy, insert, replace, and delete 
pages. To move or copy a page by using a thumbnail, you must first 
select the thumbnail.

To select thumbnails:

Click the thumbnail page-number box; Shift-click to select additional 
thumbnails. A black rectangle appears around a selected page. 

To deselect thumbnails: 

Click outside a black rectangle to deselect all thumbnails. 
Shift-click the page number box to deselect one of multiple 
selected thumbnails. 

To move pages within a document:

Select one or more thumbnails, and drag them to the new location. A 
page icon appears at the tip of the pointer, and a black bar appears 
above or to the left of the new position. When you release the mouse 
button, the moved pages are inserted and all subsequent pages are 
renumbered.



Book name & version goes here 8/8/95 exchange2.1.big.frame

46

Understanding zoom options
When you select any of the zoom options, Fit Page, Fit Width, or 
Fit Visible, the magnification is retained throughout the document 
until you change it. Because these zoom options persist as you page 
through a document regardless of any previously set magnification, 
they are referred to as sticky. If you open a new document that 
has no document-level zoom preference, the application’s Default 
Magnification preference setting is used. 

A sticky zoom state is indicated by a check mark next to the com-
mand in the View menu, and its associated button in the toolbar is 
highlighted. Clicking the Fit Page or Fit Width button in the toolbar 
when it is in its sticky state unsticks it. (The Actual Size button is 
never highlighted; the fact that the document is being viewed at its 
actual size is indicated by the 100% shown in the status bar.)

Selecting a zoom magnification of a specific percentage, including 
Actual Size (100%), cancels the sticky zoom state.
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Default magnification for bookmarks and links
When you create a new bookmark or link, its default magnification 
setting depends on whether you are viewing the document in a 
sticky zoom mode (using one of the Fit options) or not. If you are, 
the default magnification is this setting. If the view is not a sticky 
zoom option, the magnification defaults to the last-used nonsticky 
zoom option: Fixed, Fit View, or Inherit Zoom. 

The Inherit Zoom magnification option tells Acrobat Exchange or 
Reader to display the destination page at the magnification that the 
reader is using when they click the link or bookmark. Using this 
option enables the reader to determine the default magnifications 
for links and bookmarks as they read. When you create a link, you 
can select Inherit Zoom as the magnification option in the Create 
Link dialog box. 
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To choose the Inherit Zoom magnification option 
for bookmarks: 

1 Select the bookmark by clicking the bookmark’s page icon. 

2 Press Ctrl/Command+I to display the Bookmark Properties 
dialog box.

3 Click Set Destination in the dialog box. 

4 Choose Inherit Zoom as the Magnification, and click Set Action.
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Finding words
Use the Find command to search for part of a word, a complete 
word, or multiple words in a document from the current page to 
the end of the document. If you select Find Backwards, Acrobat 
Exchange searches the entire document, starting from the current 
page.

To search across documents that have been indexed by using the 
Acrobat Catalog program, use the Search command instead of 
the Find command. See Searching indexed document collections 
for more information.

To search for a word:

1 Click the find tool t, or choose Tools > Find. The Find dialog box 
appears. 

2 Select the Match Whole Word Only option if you want Acrobat 
Exchange to ignore words that contain the word you enter. Select the 
Match Case option if you want Acrobat Exchange to find only those 
words that contain exactly the same capitalization as you enter in the 
Find dialog box. 
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3 In the Find What text box, enter the text to be found, and click Find. 
When the program finds the text, the Find dialog box closes and the 
page containing the text is displayed with the text highlighted. 

4 To find the next occurrence of the word, press Ctrl/Command+G or 
reopen the Find dialog box and click Find Again.
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Copying text to the Clipboard
You can select text in a PDF document, copy it to the Clipboard, 
and paste it into a document in another application, such as a word 
processor. When you select formatted text to be copied to the 
Clipboard, formatting is maintained at the highest level supported. 

Once the selected text is on the Clipboard, you can switch to 
another application and paste the text into another document. You 
can also paste the text into a PDF document note or a bookmark.

If the other application supports Object Linking and Embedding 
(OLE), you can use OLE commands to paste text into an OLE 
compound document. See Acrobat and OLE for more information

Note: If a font copied from a PDF document is not available on the 
system displaying the copied text, the font cannot be preserved. 
Helvetica is substituted.

To select text in single-column format and copy it to 
the Clipboard:

1 Click the text selection tool g, or choose Tools > Select Text. The 
pointer changes to an I-beam.
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2 Choose one of two options:

• If the text is in single-column format, drag to select the text you 
want to copy.

• If the text is in multiple-column format, hold down Control 
(Windows) or Option (Macintosh) and drag to select the text you 
want to copy. 

When you release the mouse button, the selected text is highlighted. 
(To deselect the text and start over, click anywhere outside the 
selected text.)

3 Choose Edit > Copy to copy the selected text to the Clipboard. To 
view the text, choose Window > Show Clipboard. 
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Copying graphics to the Clipboard
You can select a graphic in a PDF document, copy it to the Clipboard, 
and paste it into a document in another application. If you select 
part of a page, the bitmap image of the screen is captured at the 
screen’s resolution and copied to the Clipboard as a Metafile (in
Windows) or as a PICT file (on the Macintosh).

Once the selected graphic is on the Clipboard, you can switch to 
another application and paste the graphic into another document. 

To select graphics and copy them to the Clipboard:

1 Choose Tools > Select Graphics. The pointer changes to a 
cross hair (+).

2 Drag to select the graphic you want to copy. When you release the 
mouse button, the selected area is highlighted. (To deselect the 
graphic and start over, click anywhere outside the selected area.)

3 Choose Edit > Copy to copy the selected graphic to the Clipboard. 
To view the selection, choose Window > Show Clipboard. 
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Search tips
When you begin using the Search command, you might encounter 
the following two problems:

• A search finds too many documents. A search for a single word 
can, for example, return hundreds of documents—far too many to 
open and view.

• A search finds too few, or no documents.

This topic gives advice for solving both of these problems.

Handling a search that finds too many documents
When a search returns too many documents, you can use the follow-
ing techniques to restrict or refine the results of the search.

• Ignore documents with a medium or low relevance ranking. By 
default, found documents are listed in order of a relevance ranking. 
The information you seek might be in the documents with the 
highest relevance ranking.
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• Use AND to limit searches to documents that contain two or more 
words or phrases. You can search, for example, for documents that 
contain North and Nicaragua and senate hearings. You can also use 
NOT to find documents that contain one, two, or more words but not 
another word. You can search, for example, for documents that 
contain human and fossil but not piltdown. See Searching with AND, 
OR, and NOT for more information about AND and NOT.

• When you use AND to search for documents containing two or 
more words, you can use the Proximity search option to change the 
way found documents are assigned a relevance ranking. With the 
Proximity option selected, the closer together the words are in a 
document, the higher the relevance ranking. The Proximity option 
also requires that terms in an AND search be within three or four 
pages of one another to be found.

• Use the Refine Search feature to limit a search to the documents 
returned by a previous search. You can, for example, first find all the 
documents that contain the phrase Anaconda project. Then, by 
using the Refine option, you can enter any combination of search 
terms and options, and the search will be limited to only those docu-
ments that also contain Anaconda project.
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• Use field values to restrict searches to only those documents with 
field values you specify. When searching an index of English litera-
ture, for example, you can limit a search to just those documents 
that have an Author field that contains Shakespeare and a Title field 
that contains king.

• Use date ranges to restrict searches to only those documents that 
were, for example, created before a specific date or modified after a 
specific date.

• Use the Match Case search option to limit searches to documents 
that contain the words or phrases that are capitalized exactly like 
the search word or phrase you enter.

Locating hard-to-find information
If a search returns too few documents, first make sure that the 
search is set up correctly. Make sure that you are using the index or 
indexes built for the documents that contain the information you 
seek. Also, make sure that you don’t have search options selected or 
field values entered from a previous search.
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If a search is set up correctly and too few documents are returned 
from the search, use the following techniques to increase the 
number of found documents:

• Use the Word Stemming search option to find words that share a 
stem with a search word. Searching for programming, for example, 
also finds program and programs, but not programmer. 
(See Word Stemming search option for details).

• Use OR to search for alternative spellings of the same word or 
to search for two or more words that are used to describe the infor-
mation for which you are searching. When looking for information 
about political revolutions, for example, you might search for 
revolution or coup or uprising. See Searching with AND. OR, and 
NOT (Boolean expressions) for more information about OR searches.

• Use the Thesaurus search option to find words that have the same 
meaning as the search word. Searching for crypt, for example, also 
finds grave, mausoleum, sepulcher, and tomb.
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• Use the Sounds Like search option to find different spellings of 
last names. Searching for Smith, for example, also finds Smythe. 
(Searching for Smith, however, also finds send and somewhat. See 
Using the Word Assistant for a way to use the Sounds Like feature 
without finding irrelevant terms.)
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Starting a search
1 Choose Search > Query from the Tools menu, or click the Search 

button v on the toolbar.

2 Select one or more indexes. The indexes represent the document 
collections you want to search.

3 Choose one or more of the following options:

• Enter a search term, phrase, or Boolean expression. You don’t have 
to enter search text; you can perform a search with just Document 
Info field values or a document creation or modification date range.

• Enter one or more Document Info field values, either to limit your 
search or to find documents with field values you specify.

• Enter a creation or modification date range, either to limit your 
search or to find documents created or modified in the periods you 
specify.

• Choose one or more search options.
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4 Click Search to perform the search. Acrobat Exchange searches the 
index or indexes and displays a list of all the found documents in the 
Search Results window.

5 View the search results. By default, the documents returned from a 
search are listed according to a score (or relevance ranking), which 
places the documents most likely to contain relevant information at 
the top of the list. Double-click a document title to display the first 
page that contains a search term in that document. With one of the 
documents returned from the search displayed, you can use the 
Search Next and Search Previous buttons to see all the pages 
containing search terms in all the documents returned from the 
search.

See Viewing search results for more information.

After performing a search, you can use the Refine feature to perform 
another search that is limited to just those documents returned by 
the previous search.
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Selecting indexes to search
The Search command searches for words and character sequences in 
documents that have been indexed by the Acrobat Catalog program. 
By selecting a single index, you can find words and terms in any 
document in the collection of indexed documents. By selecting two 
or more indexes, you can search for words in two or more collec-
tions at the same time. 

To use an index, you must add it to the list of available indexes. As 
you search for information, you choose which indexes to search, by 
selecting and deselecting indexes in the list of available indexes.

To help decide which index to use for your search, you might want 
to view a description of an index. See Viewing information about 
indexes for instructions.

The following pages tell you how to do the following:

Select indexes for your search

Add an index to the search list

Remove an index from the search list
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To select one or more document indexes to search:

1 Click the Indexes button in the Acrobat Search window. 
Alternatively, choose Search > Indexes from the Tools menu. 
The Index Selection dialog box appears.

Indexes with
checked boxes
are selected
for searching.

List of indexes
that have been
added
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2 Click the check box to the left of the index you want to use.

3 Click OK to close the Index Selection dialog box and return to the 
Search window.

Note: Dimmed indexes are currently unavailable for searching. 
Usually, an index is unavailable because the network connection 
between your computer and the server where the index resides has 
been lost. See The index is unavailable for more information.

To add an index to the search list:

1 Select Search > Indexes from the Tools menu, or if the Acrobat 
Search window is already open, click the Indexes button. The Index 
Selection dialog box appears.

2 Click Add. The Add Index dialog box appears.

3 Locate and select the index you want to use. Acrobat index 
definition filenames end with .pdx.

4 Click OK (with Windows) or Open (on the Macintosh) to select the 
index and close the Add Index dialog box. Alternatively, double-click 
the name of the index you want to use. The new index is added to the 
search list.
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To remove an index from the search list:

1 Click the Indexes button in the Acrobat Search window. Alterna-
tively, Choose Search > Indexes from the Tools menu. The Index 
Selection dialog box appears.

2 Click to highlight the name of the index you want to remove.

3 Click Remove. The index is removed from the list.

4 Click OK to return to the Acrobat Search window.
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Viewing information about indexes
After you have added an index to the search list, you can display the 
following information about the index:

• Title is the index name that appears in the Index Selection dialog 
box.

• Description is the index description written by the publisher who 
created it.

• Path is the location and name of the PDX index file as seen from 
your computer.

• Last Built is the date the index was last updated to include new 
and changed documents.

• Created is the date the index was created.

• Documents is the number of PDF documents in the collection of 
indexed documents.
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• Status indicates the index’s current status. Available means that 
you can select the index for searching. Unavailable means that 
Acrobat Search cannot open the index files, usually because the 
network connection to the server containing the index files has been 
lost. You cannot search an unavailable index. Not Loaded means the 
index has not been selected; it may or may not be available for 
searching.

To display information about an index:

1 Click the Indexes button in the Acrobat Search window. Alterna-
tively, choose Search > Indexes from the Tools menu. The Index 
Selection dialog box appears.

2 Click to highlight the name of the index in which you are interested.

3 Click Info. The Index Information dialog box appears.
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Searching for a single term
To find occurrences of single term, enter the term in the Find text 
box and click Search. A search term can be a word, a word with 
wild-card characters, or any combination of letters, numbers, and 
symbols.

You cannot find stopwords, which are words excluded from an 
index, and you might not be able to find numbers. Contact the 
person who created the index to learn which words, if any, are 
excluded from the index and whether numbers are included in the 
index.

You can use the Match Case, Word Stemming, Sounds Like, and 
Thesaurus options when searching for a single term. The Match 
Case, Word Stemming, and Sounds Like options might not be avail-
able with all indexes, because index publishers can choose not to 
add support for these features.

You can also use Document Info and Document creation and 
modification date field values to limit the number of documents 
returned by a search for a single term.
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See About Acrobat indexes for a description of how the Acrobat 
Catalog program recognizes words and other terms in PDF 
documents and how index publishers can prevent stopwords 
and numbers from being included in an index.
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Searching for a phrase
To search for a phrase, type the phrase in the Find text box and click 
Search. For example, 

status report

finds all occurrences of status report, Status report, and Status 
Report, as well as all other combinations of uppercase and lowercase 
letters for the phrase status report.

You can use a phrase as part of a Boolean expression. For example,

status report AND anaconda project

finds all documents that contain both the phrase status report and 
the phrase anaconda project.

If the phrase you want to find contains a Boolean operator, you must 
enclose the phrase in quotation marks. For example,

“cats and dogs” OR “rain or shine”

finds all documents that contain either the phrase cats and dogs or 
the phrase rain or shine.
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Use the Match Case option to find phrases that are capitalized 
exactly like the phrase you enter in the Find box.

The Thesaurus, Sounds Like, and Word Stemming options have no 
effect on phrase searches.

You can use Document Info and Document creation and 
modification date field values to limit the number of 
documents returned by a search for a phrase.

Stopwords and phrase searches
Phrases that include stopwords cannot be found as phrases. For 
example, if Lincoln’s Gettysburg address is indexed with the typical 
stopword list—which includes of, the, by, and for—users cannot find 
the address by searching for its most famous phrase,

Of the people, by the people, for the people

or with

people people people
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which is how—with the typical stopword list—the phrase is indexed. 
In this case, the only way to find the words in Lincoln’s famous 
phrase is to search for people. The limitation that stopwords place 
on phrase searches is a good reason not to exclude stopwords from 
an index. However, stopwords reduce the size of an index, which is 
why they are sometimes excluded from indexes.

Punctuation and other special characters in phrase searches
Acrobat Search ignores any punctuation characters you enter as part 
of a phrase.

For example, the search phrase Go home! finds Go home! but it also 
finds string such as I want to go home and Go home? You must be 
joking.

Similarly, Acrobat Search ignores other special characters such as 
the at sign [@] and the asterisk [*]. See How terms are indexed for 
details.
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Searching with wild-card characters
You can use wild-card characters to find all the words that contain a 
word fragment or all the words and terms that match an arbitrary 
character pattern. The wild-card characters are the following:

* the asterisk, which matches zero, one, or more characters

? the question mark, which matches any one character

Wild-card examples
geo* matches words such as geode, geodesic, Geoffrey, 

geography, geometry, George, and geothermal

*nym matches words such as antonym, homonym, and synonym

?ight matches words such as fight, light, might, right, and sight

555-? ? ? ? matches all seven-digit phone numbers with the 555 prefix 

pr?m* matches words such as premature, premeditate, prim, 
primate, promise, and promontory
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You can use wild-card characters in a term that is part of a 
Boolean expression. You can also use wild-cards to specify 
Document Info field values.

Note: You cannot use wild-card characters to represent separator 
characters such as the hyphen [-] and the slash [/]. When the 
Catalog program builds an index, it uses separator characters to 
recognize where words begin and end and does not place them in 
the index. To find both begin/end and begin-end, for example, you 
cannot search for begin?end . Searching for begin?end  finds neither 
begin/end nor begin-end. To find both, you must search for the 
phrase begin end, or for both begin/end and begin-end. See 
How terms are indexed for a description of separator characters.
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Limiting search results with Document Info fields
You can use Document Info field values to limit the results of your 
searches to just those documents that contain specific field values. 
To add the Document Info fields to the Search window, choose 
Preferences > Search from the Edit menu and select Show Fields in 
the Preferences dialog box.

When you enter a Document Info field value or expression, only 
documents with fields that contain the value and that meet the 
search criteria are returned.
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Document Info fields may be empty, because PDF document creators 
are not required to enter field values. You may also see additional 
fields not described in this guide, because PDF document creators 
can add custom fields. If you are using Acrobat Exchange, you can 
enter or change field values. 

When you enter one or more Document Info field values or expres-
sions in the Find text box, you do not have to enter a search term. 
You can use fields to find all the documents that contain a specified 
field value.

Note: The Title field contains a document title that has been 
entered by the author. For Macintosh documents, it does not con-
tain the Macintosh filename unless the author entered the filename 
as a title.
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Using two or more fields
Entering values for two or more fields specifies an AND condition. 
Documents must contain all the field values you specify. For exam-
ple, if you enter Samuelson in the Author field, cost analysis in the 
Subject field, and spreadsheet in the Keywords field, only documents 
that contain these values in these fields are returned from subse-
quent searches.
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Wild-card characters
You can use wild-cards in Document Information text boxes. For 
example, if you enter

Sm?th*

in the Author text box, documents with Author field values that 
include Smith, Smyth, and Smythe can be returned with subsequent 
searches. See Searching with wild-card characters for instructions on 
how to use wild-card characters.

Boolean expressions
You can use Boolean expressions in Document Information text 
boxes. For example, if you enter

Shakespeare or Milton

in the Author text box, only documents that include either 
Shakespeare or Milton in the Author field are found. See Searching 
with AND, OR, and NOT (Boolean expressions) for instructions on 
how to build Boolean expressions.
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Boolean expressions that use more than one field
By combining the field expression with the search expression in the 
Find text box, you can build a Boolean expression that uses more 
than one field . For example, if you enter

(“Sixteen to one project” OR “16 to 1 project”) AND 
(Author ~ Raskin) AND (Keywords ~ “slide show” OR 
keywords ~ presentation OR keywords ~ spreadsheet)

in the Find text box, the search returns only documents that 

• contain either the phrase sixteen to one project or 
16 to 1 project and

• Have an Author field that contains Raskin, and

• Have a Keywords field that contains either the phrase slide show 
or the word presentation or spreadsheet.

The tilde [~] operator is described in the following section.
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Operators that can be used only with Document Info fields
Certain operators can be used only in Document Info field values. 

Operator Meaning
= matches exactly (for text, numeric, and date values)

~ contains (for text values)

!= does not contain (for text, numeric, and date values)

< is less than (for date or numeric values)

<= is less than or equal to (for date or numeric values)

> is greater than (for date or numeric values)

>= is greater than or equal to (for date and numeric values)

The comparison operators (<, <=, >, and >=) can be used only with 
values of the same type. For example, a date value can be compared 
only with another date value, and a text value can match exactly 
only another text value.

The standard Document Info fields—Title, Subject, Author, and 
Keywords—are all type text. 
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Limiting search results by document creation and 
modification dates
You can use the Date Info fields to limit search results to just those 
documents that were created or modified in a specific time period. 
To add the Date Info fields to the Acrobat Search window, choose 
Preferences > Search from the Edit menu and select the Show Date 
option.

To specify a date:

1 Click the month field box for the date you want to specify, and enter 
the number of the month. The current day and year appear in the day 
and year fields.

2 To change the day, click the day field and either enter the day 
number or use the up and down arrows to select the day number.
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3 To change the year, click the year field and either enter the year or 
use the up and down arrows to select the year.

To limit a search to documents created or modified after a 
specific date:

Specify the After date, and leave the Before date blank.

To limit a search to documents that were created or 
modified before a specific date:

Specify the Before date, and leave the After date blank.

To clear the date fields:

Click Clear.

To use both the creation and modification dates:

Entering time periods for both creation and modification dates 
specifies an AND condition. Only documents created in the specified 
period and modified in the specified period are returned from a 
search.
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Using search options
The search options expand and restrict the results of searches with 
single terms, phrases, and Boolean expressions. The search options 
do not apply to Document Information field values. To add the 
search options to the Acrobat Search window, choose 
Preferences > Search from the Edit menu and select Show Options.

• Word Stemming finds words that share a stem with the search 
term.

• Thesaurus finds words that have the same meaning as the search 
term.

• Sounds Like finds words that share a phonetic resemblance to a 
search term.

• Match Case finds only words that are capitalized exactly like the 
search term.

• Proximity changes AND searches so that words must be within 
three or four pages of one another.
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See also Using the Refine search feature.

You can use the Word Assistant to see the effects of using the 
Word Stemming, Thesaurus, and Sounds Like search options 
before performing a search. Choose Search > Word Assist from 
the Tools menu to display the Word Assistant dialog box.
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Word Stemming search option
Word stemming expands the search to find words that share word 
stems with the search terms you enter in the Find box. For example, 
with Word Stemming selected, searching for building finds build and 
builds as well as building.

Note: The Word Stemming option does not find words that end 
with er. For example, searching for build does not find builder, 
searching for bake does not find baker, and searching for publish 
does not find publisher.

Use the Word Assistant dialog box to see all the words in the current 
index or indexes that share a stem with a specified search term. 
Choose Acrobat Search > Word Assist from the Tools menu to 
display the Word Assistant dialog box.

The Word Stemming feature does not apply to terms that contain 
wild-card characters.
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You cannot use the Word Stemming option with the Match Case 
option. When Word Stemming is selected, the Match Case option is 
ignored.

Not all indexes support the Word Stemming option; index publishers 
must build support for word stemming into indexes. When an index 
does not support word stemming, selecting the option has no effect.
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Thesaurus search option
Thesaurus expands the search to find words that bear some seman-
tic resemblance to the search terms you enter in the Find box. For 
example, with Thesaurus selected, searching for begin finds start, as 
well as attack, produce, and many other terms.

Sometimes the number of words that the search feature considers to 
have the same meaning as a given search term is surprising. Before 
searching with the Thesaurus option, it is usually a good idea to use 
the Word Assistant to see all the words that the Search feature con-
siders to have the same meaning as a specific search term. Choose 
Acrobat Search > Word Assist from the Tools menu to display the 
Word Assistant dialog box.

The Thesaurus feature does not apply to terms in a search phrase or 
to terms that contain wild-card characters.

You cannot use the Thesaurus option with the Match Case option. 
When the Thesaurus option is selected, the Match Case option is 
ignored.
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Sounds Like search option
Sounds Like expands the search to find words that begin with 
the same letter as a search term and that share some phonetic 
relation to a search term. For example, with Sounds Like selected, 
searching for Smith also finds Smyth and Smythe. Searching for 
Smith, however, also finds send and somewhat. Before searching 
with the Sounds Like option, it is usually a good idea to use the 
Word Assistant to see all the words that the Sounds Like option will 
find. To display the Word Assistant dialog box, choose 
Search > Word Assist from the Tools menu.

The Sounds Like feature does not apply to terms in a search phrase 
or terms that contain wild-card characters.

You cannot use the Sounds Like option with the Match Case option. 
When Sounds Like is selected, the Match Case option is ignored.

Not all indexes support the Sounds Like option; index publishers 
must build support for the Sounds Like option into indexes. When an 
index does not support Sounds Like, selecting the option has no 
effect.
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Match Case search option
Match Case limits the results of the search to find only those docu-
ments that contain words with the same capitalization as the search 
term or terms you enter in the Find box. With Match Case selected, 
for example, searching for He finds all occurrences of He, the 
symbol for Helium, but not occurrences of he, the common 
pronoun.

You can use the Match Case option with phrase searches, and the 
Match Case option applies to any terms you use with a Boolean 
expression.

You can also use the Match Case option with terms that contain 
wild-card characters. Characters matched by wild-card characters, 
however, can be either uppercase or lowercase.

You cannot use the Match Case option with the Word Stemming, 
Thesaurus, or Sounds Like options. When any of these options are 
selected, the Match Case option is ignored.
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Not all indexes support the Match Case option; index publishers 
must build support for the Match Case option into indexes. When an 
index does not support Match Case, selecting the option has no 
effect on searches.
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Proximity search option
Proximity changes the way AND searches work. With Proximity 
selected, words in an AND search must be within two or three pages 
of each other to be found. Without the Proximity option, two words 
may appear anywhere in a document and still be found by an AND 
search.

Also, the closer the words are in the document, the higher the
relevance ranking of the document in which they appear.
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Using the Word Assistant

 

The Word Assistant dialog box shows how the Sounds Like, Word 
Stemming, and Thesaurus search options affect a search query. Use 
the Word Assistant to see which terms, in addition to the search 
term, will be found with a search option selected.
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You can also cut terms from the Word Assistant dialog box and paste 
them into the Search window to construct quickly a list of terms to 
find. Cutting and pasting terms is especially useful for the long lists 
of words that are often suggested by the Thesaurus or Sounds Like 
option.

To see the effects of a search option on a search term:

1 Choose Acrobat Search > Word Assist from the Tools menu. The 
Word Assistant dialog box appears.

2 If you do not want to use your current indexes, click Indexes to 
display the Index Selection dialog box and select the indexes you want 
to use.

3 Select the search option from the Assist menu. 

4 Enter the search term in the Word text box.

5 Click Lookup. All the words that will be found are listed in the 
scrolling list.
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To search with a term listed in the Word Assistant 
dialog box:

1 Click the Search button to display the Search window.

2 Choose Search > Word Assistant from the Tools menu to display the 
Word Assistant dialog box.

3 Enter the search term in the Word box, select the search option from 
the Assist list, and click Lookup. The related words are listed in the list 
box.

4 Double-click a word that you want to use. The word appears in the 
Word text box.

5 Double-click the word in the Word text box to select it, and press 
Ctrl/Command+C to copy it. 

6 Click the Search window title to select it; then click the Find text box 
and press Ctrl/Command+V to paste the selected word into the text 
box. 

7 Repeat steps 4 through 6 for each word you want to use; separate 
each pair of words in the Find text box with OR.
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Using the Refine search feature
Refine search restricts the next search to only those documents 
found by the previous search. Only documents currently listed in the 
Search Results window are searched.

To use the Refine search feature:

1 Use any combination of search terms, Document Info field values, 
Date Info field values, and search options to perform a search. The 
found documents are listed in the Search Results window.

2 With one or more documents in the Search Results window, click the 
Search Query button in the toolbar to open the Acrobat Search 
window.

3 Enter any new combination of search terms, Document Info field 
values, Date Info field values, and search options.

4 Press Ctrl (for Windows) or Option (on the Macintosh) and click the 
Refine button. (Pressing Ctrl or Option with documents in the Search 
Results list changes the Search button to the Refine button.) The 
Search Results window lists documents that were previously in the 
Search Results list and that meet the new search criteria.
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Searching with AND, OR, and NOT
(Boolean expressions)
You can use AND, OR, and NOT operators to build a Boolean expres-
sion that specifies combinations of words that a document must 
have to be returned by a search.

Suppose, for example, you were searching a collection of U.S. 
history articles for information about Noah Webster, who wrote the 
first U.S. American English dictionary. If you searched for Webster, 
you would find references to Noah Webster, but you would also find 
references to Daniel Webster, a nineteenth century U.S. senator from 
Massachusetts. To find references to Noah Webster and avoid 
references to Daniel Webster, you could search for articles that 
contain Webster and dictionary but not congress or senate.

You can also use Boolean expressions in Document Info field text 
boxes to specify a combination of field values that documents must 
contain to be returned from a search.
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See the following topics for more information about Boolean 
expressions:

AND searches

OR searches

NOT searches

Combining Boolean operators

Using parentheses to change the order of evaluation

Using operator names and parentheses in a Boolean expression

For information about using Boolean expressions to specify 
Document Info field values, see also Searching with AND, OR, 
and NOT (Boolean expressions) or Limiting search results with 
Document Info fields.
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AND searches
Use AND to specify two or more search terms that a document must 
contain to be returned by a search. For example,

installation AND instructions

finds only those documents that contain both installation and 
instructions.

You can also use the ampersand [&] to specify an AND search. 
For example, 

installation & instructions

also finds documents that contain both installation and instructions.
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Choosing the Proximity search option changes the way AND 
searches work. Without the Proximity option, terms in an AND 
search can be anywhere in a document. Searching for red and blue, 
for example, can find a document in which red is the first word 
on the first page and blue is the last word on the last page. With 
the Proximity option, however, terms in an AND search must be 
within two or three pages of each other to be found. Also, with the 
Proximity option selected, the closer the terms appear together, the 
higher the relevance ranking of the document that contains them.
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OR searches
Use OR to specify two or more search terms, any of which a 
document can contain and be returned by a search. For example, 

television OR tv

finds all documents that contain either television or tv.

You can also use a comma [,] or a vertical bar [|] to separate terms in 
an OR search. For example,

television, tv

and

television | tv

also find all documents with either or both television and tv.

Although any document that contains any term used with an OR 
operator is returned from a search, documents that contain both 
terms rank higher in the Search Results list. See Relevance ranking 
for more information.
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NOT searches
Use NOT to exclude documents that contain a search term. For 
example,

not quarterly

finds all documents that do not contain the word quarterly.

You can also use an exclamation point [!] to specify a NOT search. 
For example, 

! quarterly

also finds all documents that do not contain the word quarterly.

Note: You must place a space between the exclamation point and 
the search term.
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Combining Boolean operators
This topic explains how to combine Boolean operators in a search 
query.

Caution: Be careful when combining operators to build Boolean 
expressions. Unless you work with Boolean expressions frequently, 
it is easy to build an expression that does not mean what you think 
it means.

Combining AND and OR operators
When you combine AND and OR in the same expression, AND is 
evaluated before OR. For example,

darwin OR origin AND species

finds all documents that contain darwin or that contain both 
origin and species.
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Combining AND, OR, and NOT operators
When NOT is used with either or both of the AND and OR operators, 
it is evaluated before either the AND or OR. For example,

evolution AND not darwin

finds all documents that contain the word evolution but not darwin.

Using parentheses to change the order of evaluation
You can use parentheses to change the default order of evaluation 
for Boolean operators. For example,

(darwin or origin) AND species

finds all documents that contain either darwin and species or that 
contain origin and species. Parentheses can be nested to any depth.
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Using operator names and parentheses in a 
Boolean expression
When you use a phrase that contains operator names or parentheses, 
the phrase must be enclosed in quotes. For example, 

“cats and dogs” OR “cats & dogs”

finds all documents that contain either the phrase cats and dogs or 
the phrase cats & dogs.

Similarly, when you use a search term that contains an operator 
character or parentheses, the term must be enclosed in quotes. 
For example,

“(cats|dogs)”

finds all documents that contain the term (cats|dogs) as well as all 
documents that contain the phrase cats dogs. The phrase cats dogs 
is found because parentheses and the vertical bar are discarded 
before terms are entered into the index. They are also discarded 
when a search is performed. See How terms are indexed for details.
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As another example,

“origin of the species” OR “step 36(a)” AND “cats and dogs”

finds all documents that contain the phrase origin of the species, or 
that contain both the phrase step 36(a) and the phrase cats and 
dogs.

When the following words and characters are used within a phrase, 
the phrase must be enclosed in quotation marks:

AND &[AND operators]

OR |,[OR operators]

NOT ![NOT operators]
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Viewing search results

 

When you enter a search query, Acrobat Exchange lists in the Search 
Results window the documents it finds.
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To view a document returned from the search:

1 Select the document name, and click View (or double-click the 
document’s name). After opening a document returned from the 
search, use the Acrobat Search buttons on the toolbar to view all 
the pages containing search terms.

2 To highlight the next occurrence of a search term, click the Search 
Next button y. When the last occurrence of a search term in a docu-
ment is displayed, Search Next displays the first occurrence in the 
next document. Search Next displays documents in the order that they 
are listed in the Search Results window. Pressing the Shift key and 
clicking Search Next displays the first occurrence of a search term in 
the next document.

3 To highlight the previous occurrence of a search term, click the 
Search Previous button x. When there are no more occurrences of a 
search term in a document, the last occurrence of a search term in the 
previous document is displayed. Search Previous displays documents 
in the reverse of the order in which they are listed in the Search 
Results window. Pressing the Shift key and clicking Search Previous 
displays the first occurrence of a search term in the previous 
document.
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Changing the order in which found documents are listed
By default, documents are listed in the order of their score or 
relevance ranking, which places the documents most likely to 
contain relevant information at the top of the list. With the Acrobat 
Search Preferences dialog box, you can change the order in which 
documents are listed . For example, you can sort documents by cre-
ation date, by title, or by author. Choose Preferences > Search from 
the Edit menu to display the Acrobat Search Preferences dialog box.

Changing the way Acrobat Search displays found terms
By default, all the search terms on a page are highlighted and the 
Search Next and Search Previous buttons display the next and previ-
ous pages with found terms. You can, however, change the way 
found terms are highlighted by changing the Highlight option in the 
Acrobat Search Preferences dialog box: 

• By Word highlights search terms one at a time; each click of the 
Search Next or Search Previous button moves the highlighting from 
one term to the next.
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• No Highlighting displays pages with found terms without 
highlighting terms; each click of the Search Next or Search 
Previous button displays a new page.

• By Page, the default, displays pages with all found terms 
highlighted; each click of the Search Next or Search Previous 
button displays a new page.

Choose Preferences > Search from the Edit menu to display the 
Acrobat Search Preferences dialog box.

Limiting the number of documents returned by a search
By default, Acrobat Exchange lists no more than 100 documents 
in the Search Results list. You can, however, change this limit to 
a higher or lower number in the Acrobat Search Preferences 
dialog box. 

The minimum is 1 document; the maximum is 1000 documents.

Choose Preferences > Search from the Edit menu to display the 
Acrobat Search Preferences dialog box.
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Keeping the Search Results window open 
By default, the Search Results window closes when you view a docu-
ment returned from a search. You can, however, keep the Search 
Results window open while viewing search results by clearing the 
Hide on View option in the Acrobat Search Preferences dialog box. 
Choose Preferences > Search to display the Search Preferences dialog 
box.
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When you keep the Search Results window visible while viewing 
search results, the Search Results window reports how many docu-
ments were found, how many pages in the current document contain 
a search term, and which page in the current document is being 
displayed.
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Relevance ranking (score)
Acrobat Exchange assigns a relevance ranking to every document 
returned from a search. A document’s relevance ranking indicates 
how likely it is that the document contains the information for which 
you are searching.

Acrobat Search uses five icons to indicate a document’s relevance 
ranking:

A full circle indicates a very high relevance ranking; the 
document is very likely to contain relevant information.

A three-quarter circle indicates a high relevance ranking; the 
document is likely to contain relevant information.

A half circle indicates a medium relevance ranking; the 
document probably contains relevant information.

A one-quarter circle indicates a low relevance ranking; the 
document might contain relevant information.

An empty circle indicates a very low relevance ranking; the 
document is unlikely to contain relevant information.
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The method used to determine a document’s relevance ranking 
depends on the kind of search performed. With a single search term, 
for example, the relevance ranking indicates how frequently the 
term appears in the document. When two search terms are separated 
by an OR operator, however, documents that contain both terms 
have a relevance ranking higher than documents that contain just 
one of the terms. Similarly, when you use the Proximity search 
option, the closer search terms are within a document, the higher 
the relevance ranking for the document.

Another factor that contributes to a document’s relevance ranking is 
the density of search terms relative to other terms in the document. 
The higher proportion of search terms in a document, the higher the 
document is ranked.
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Search preferences
You can use the Acrobat Search Preferences dialog box to

• Control whether the Search window closes when you perform a 
search

• Control the size and contents of the Search window. (You can 
show or hide the Document Info fields, the document date fields, 
and the search options.)

• Control whether the Search Results window closes when you view 
a document returned from a search

• Control the number of found documents listed in the Results 
window, and the order in which they are listed

• Control whether all search terms on a page are highlighted, 
whether terms on a page are highlighted one at a time, or whether 
no terms are highlighted

• Control whether Macintosh file server volumes that contain 
indexes you are using are automatically mounted when you start 
Acrobat Search



Book name & version goes here 8/8/95 exchange2.1.big.frame

177

See Query preferences for details about the preference settings that 
control the Acrobat Search window. See Results preferences for 
details about the preference settings that control the Search Results 
window. See Indexes preference for details about the index file 
server automount setting.
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Query preferences
The Query preferences control the size, contents, and behavior of 
the Acrobat Search window.

• Show Fields displays the Document Info fields with the Search 
window.

• Show Options displays the search options with the Search 
window.

• Show Date displays the Date Info selection options with the 
Search window. The Date Info options let you limit the results of a 
search to documents that were created or modified during a specific 
time period.

• Hide on Search closes the Search window when you perform a 
search; clear this option to keep the Search window displayed while 
you view search results.
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Results preferences
The Search Results preferences control the behavior of the Search 
Results window.

• Sort By controls the order in which documents are listed in the 
Search Results window. By default, documents are sorted by score, 
which lists them in the order of their relevance ranking. You can also 
sort found documents by creation date, modification date, or by one 
of the Document Info field values, such as Title or Author. When you 
sort found documents by Document Info field values, they are listed 
alphabetically by field values.



Book name & version goes here 8/8/95 exchange2.1.big.frame

180

When you sort by Created or Modified date values, documents are 
sorted by date in descending order. The most recent dates are listed 
first.

Documents with empty fields are listed before documents with field 
values.

When documents are sorted by score, documents with the same 
score are listed alphabetically by title (or filename if they have no 
title).

When documents are sorted by any value other than score, 
documents with the same sort value are sorted by score.

• Show Top __ Documents defines the maximum number of 
documents you want Acrobat Search to return from a search. 
Enter any value between 1and 1000.

• Hide on View closes the Search Results window when you view a 
document returned from a search; clear this option to keep the 
Search Results window visible while you view search results.
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• Highlight Display controls how Acrobat Search highlights found 
search terms and how the Search Next and Search Previous buttons 
work.

• By Page highlights all the search terms on a page. Search Next 
and Search Previous display the next or previous page with found 
terms.

• By Word highlights found search terms one at a time. Search Next 
and Search Previous highlight the next or previous found term.

• No Highlighting does not highlight search terms. Search Next 
and Search Previous display the next or previous page that contain 
found terms.
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Indexes preference (for Macintosh only)
The Indexes preference controls whether network file servers that 
contain currently selected indexes are automatically mounted when 
you start Acrobat Search.

Select Automount Servers to connect automatically to file servers 
that contain selected indexes. When Automount Servers is not 
selected, you must manually mount servers that contain indexes 
before you can use the indexes.
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About Acrobat indexes
The Acrobat Catalog program creates full-text indexes for collections 
of PDF documents. Acrobat Search uses these indexes to locate 
words quickly in documents that make up indexed collections.

Words and terms included in an index
By default, an Acrobat index lists every word, number, and alphanu-
meric term that appears in every document in the indexed document 
collection. An alphanumeric term is a sequence of letters and num-
bers. See How terms are indexed for details.

Stopwords
To reduce the size of an index, an index publisher can exclude stop-
words from an index. Stopwords are not indexed. Usually, stop-
words are common words that do not serve to identify topics or sub-
jects. Carefully chosen stopwords can reduce the size of an index 
without reducing its usefulness.
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Typical stopwords include

• Articles such as the and a

• Prepositions such as for, by, and of

• Conjunctions such as or and and

Each index can be built with a different stopword list.

Because they are not placed into the index, you cannot find stop-
words with Acrobat Search. Also, you cannot find a phrase that con-
tains a stopword.

See Typical stopword list for a list of common stopwords.

Numbers
Another way index publishers can reduce the size of an index is to 
exclude numbers from an index. See How Acrobat Catalog excludes 
numbers for a description of how the Catalog program identifies 
numbers.
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Full-text indexes
A full-text index is an alphabetized list of all the words and alphanu-
meric terms that occur in a collection of documents. For each word 
and alphanumeric term in the document collection, a full-text index 
lists the documents and pages where the word or term appears. 
Given a full-text index, search software can quickly locate all the 
occurrences of a search term without opening and searching the 
documents. The following table shows part of a full-text index for 
Shakespeare’s plays.

Term Document (Play) Pages
abed All’s Well That Ends Well 150

As You Like It 36

Cymbeline 86

Macbeth 35

Othello 82

Romeo and Juliet 111, 142

Twelfth Night 38
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Term Document (Play) Pages
abel First Part of King Henry VI 25

Abel’s King Richard II 9

Abergavenny Henry VIII 2, 6, 9, 10, 11, 19, 28

abet King Richard II 71

abetting Comedy of Errors 33

Note: Indexes distinguish between uppercase and lowercase letters 
only when publishers build them to support the Match Case option. 
Otherwise, all index terms are spelled with lowercase letters.

See How terms are indexed for a description of how the Acrobat 
Catalog program recognizes words and terms.
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Troubleshooting searches
This topic provides advice for solving problems you might encounter 
when using the Search command. Solutions are described under the 
error message you will see.

The index is unavailable
Indexes might be unavailable for one or more of the following 
reasons:

• The connection to the network server containing the index has 
been lost.

• The index is being purged and rebuilt; this maintenance operation 
takes time but can significantly reduce the size of an index.

• The index has been moved to a new location.

• The index has been deleted.

Contact your network administrator if you suspect you have lost 
your connection to a server.
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Contact the person responsible for the index if you suspect the 
index is being purged and rebuilt, or if you suspect that it has been 
moved or deleted.

Highlights will not be displayed
Acrobat Exchange displays this message when it tries to open a PDF 
document that has changed since the index was built. The change 
may not have altered the locations of the words on the page. Adding 
a note to a PDF document or security settings, for example, causes 
Acrobat Exchange to display this message.

If the change to the file did alter the locations of words, the search 
term highlights will be incorrect. For example, if a page was deleted, 
highlights will indicate the wrong words.

If you think the change to the PDF document did not alter the loca-
tions of words in the document, or if you think you will be able to 
tell whether the highlights are correct, click the Highlight Anyway 
button to close the message box and view the document.
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Note: Index creators can suppress this message by selecting the 
Optimize for CD-ROM option in the Adobe Acrobat Catalog Options 
dialog box. See Optimize for CD-ROM option in the Adobe Acrobat 
Catalog Online Guide.

No documents were found that matched your query
Acrobat Exchange displays this message when no documents in the 
currently selected indexes meet the criteria you specify with a 
search query. If you get this message, try these steps:

• Make sure you have selected the indexes that contain the 
documents with the information you seek.

• Make sure you are not using Document Info or Date Info field 
values—or search options from the previous query by mistake.

• Make sure you are not searching for a stopword in an index that 
has stopwords.

• Make sure you are not searching for a number in an index from 
which numbers have been excluded.

• If you are using an operator such as AND or NOT in a phrase, 
make sure the phrase is enclosed in quotation marks (“ ”).
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Out of file handles
You are running too many programs or you have too many windows 
open. Close some windows, and try the query again. If you are 
running two or more programs, quit all programs except Acrobat 
Exchange and retry the query.

Not enough memory (Macintosh)
If you get a message saying you do not have enough memory for 
Acrobat Exchange to find the documents that meet your search 
criteria, you can try increasing the memory available to the Acrobat 
Exchange program.

1 If Acrobat Exchange is running, quit the application.

2 From the Finder, click to select the Exchange program icon.

3 Choose Get Info from the File menu. The Get Info dialog box 
appears.

4 In the Memory Requirements box, increase the Minimum size value. 
For example, you might increase the Minimum size value to 2500 or 
3000. (The maximum amount of memory available for the application 
is limited by the amount of memory installed in your Macintosh.)
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5 Click the close box in the upper left corner of the Get Info dialog 
box.

6 Start Acrobat Exchange. If a message appears, telling you that there 
is not enough memory to run the program, decrease the Minimum size 
value in the Acrobat Exchange Get Info box.
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Tools menu commands
In the following command descriptions, the number to the right of 
the tool indicates the variable shortcut key for selecting the tool. 
To select the tool, press Control+Shift+this number (Windows) or 
Command+Option+this number (Macintosh).

Hand (1) selects the hand tool. To use the hand tool, drag the 
document in the direction you want it to move. 

Zoom In (2) selects the zoom-in tool. Click the tool to double the 
magnification of the page view. See Magnifying the page view for 
more information.

Zoom Out (3) selects the zoom-out tool. Click the tool to halve the 
current magnification of the page view. See Magnifying the page 
view for more information.

Select Text (4) selects the text selection tool. Drag to select text. 
Use the Copy command to copy the selected text to the Clipboard. 
See Copying text to the Clipboard for more information.
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Select Graphics (5) selects the graphics selection tool. Drag to 
select the image you want to copy. Use the Copy command to copy 
the bitmap image to the Clipboard.

See Copying graphics to the Clipboard for more information.

Note (6) selects the note tool. Drag the tool to draw a note window. 
See Using notes for more information.

Link (7) selects the link tool. Drag the tool to draw a link rectangle; 
then move to the page to which you want to link the button, and 
click OK. See Using links for more information.

Article (8) selects the article tool. Drag the tool to draw an article 
box. Release the mouse button to close the article. Continue drawing 
as many boxes as are necessary to guide the viewer through the arti-
cle. See Creating articles for more information.

Find (Ctrl/Command+F) displays the Find dialog box, which you can 
use to find part of a word, a complete word, or multiple words in a 
document. See Finding words for more information.

Find Again [Command+G(M); F3(W)] performs the same operation as 
the Find button in the Find dialog box: the next occurrence of the 
word is displayed.
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Find Next Note (Ctrl/Command+T) moves to the next page contain-
ing a note. The command does not display or open the note. 

Summarize Notes (Ctrl/Command+Shift+T) creates a PDF file that 
contains the text of all the notes in a document. See Using notes for 
more information.

The Search tools buttons enable you to search libraries of PDF docu-
ments that have been indexed by using Acrobat Catalog. 

• Search/Query (Ctrl/Command+Shift+F) displays the Search dialog 
box. 

• Search/Indexes (Ctrl/Command+Shift+X) displays the Index 
Selection dialog box. 

• Search/Results (Ctrl/Command+Shift+J) displays the Search 
Results dialog box.

• Search/Word Assistance (Ctrl/Command+Shift+W) displays the 
Word Assistant dialog box. 

• Search/Previous Document (Ctrl/Command+Shift+Y) displays 
the last occurrence of a search term in the document that precedes 
the current document in the Search Results list. 
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• Search/Previous (Ctrl/Command+Y) displays the previous occur-
rence of a search term in the current document. If there are no more 
occurrences in the current document, the last occurrence of a search 
term in the previous document is displayed. Search Previous displays 
documents in the order they are listed in the Search Results dialog 
box. 

• Search/Next (Ctrl/Command+U) displays the next occurrence of 
the search term. When the last occurrence of a word in a document 
is displayed, Search Next displays the first occurrence in the next 
document. Search Next displays documents in the order they are 
listed in the Search Results dialog box. 

• Search/Next Document (Ctrl/Command+Shift+U) displays the 
first occurrence of a search term in the document that follows the 
current document in the Search Results list. 
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Paging shortcuts

Tool or key Plus Result
Right Arrow Shift Scrolls page to the right

Left Arrow Shift Scrolls page to the left

Up Arrow Shift Scrolls page up

Down Arrow Shift Scrolls page down

Ctrl/Command 4 Last page

End key Last page

Escape key or Exit full-screen display
Command+Period 
(Macintosh)
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